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歡迎使用歡迎使用歡迎使用歡迎使用 EndNote 

EndNote 簡介簡介簡介簡介 

� EndNote 是一個線上檢索工具是一個線上檢索工具是一個線上檢索工具是一個線上檢索工具 

EndNote 讓您非常簡易且直接地查詢線上資料庫的書目（包含自各種不同

的線上資料庫，將其檢索結果以文字檔匯入），並協助您蒐集文獻至

EndNote。 

� EndNote 是一個參考文獻和圖像資是一個參考文獻和圖像資是一個參考文獻和圖像資是一個參考文獻和圖像資料庫料庫料庫料庫 

EndNote 針對您個人儲存的參考文獻在 Library 中進行書目資料儲存、管

理、查詢。您可以組織管理如圖片、表格和影像資料，並能在 EndNote 書

目管理軟體中儲存您的電子全文檔。 

� EndNote 是建立書目與草稿的軟體工具是建立書目與草稿的軟體工具是建立書目與草稿的軟體工具是建立書目與草稿的軟體工具 

EndNote 可以透過 Cite While You Write TM 功能在 Microsoft Word 中編排

引用文獻、圖表等資料。當您在撰寫文章初稿中插入引用文獻時，隨即在文

末建立您的參考文獻與圖表清單。另外，透過 Manuscripte Templates 產生

Microsoft Word 撰稿範本，指引您如何正確地撰寫文章，以滿足您發表文章

的需求。 

關於關於關於關於 EndNote 試用版和試用版和試用版和試用版和 EndNote 瀏覽器瀏覽器瀏覽器瀏覽器 

如果您使用的是 EndNote X7 試用版，就您開始啟用 EndNote 起算 30 天內，得

使用 EndNote 部分功能。經 30 天後，EndNote 試用版會變成只能瀏覽 EndNote

之功能限制的瀏覽器(EndNote Viewer)。 

關於使用手冊關於使用手冊關於使用手冊關於使用手冊 

這本手冊將為您簡介如何安裝及使用 EndNote：匯入並儲存參考書目資料、插

入參考書目至文章中等，讓您快速瀏覽、了解 EndNote 的重要功能與特色。 
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客戶服務客戶服務客戶服務客戶服務 

� EndNote 使用手冊和線上輔助說明 

EndNote 使用手冊：於安裝完 EndNote 後，會在 EndNote 資料夾中內建一

個完整的 EndNote 使用手冊(PDF 檔)。在 C:\Program Files\EndNote X7 的

路徑下有一份 EndNoteX7WinHelp.pdf 的檔案，開啟即是一份完整的英文版

使用手冊。 

EndNote 線上輔助說明：您可自 EndNote 程式的 Help 選單，點選 Contents

瀏覽不同主題說明；或是點選 開始 → 所有程式 → EndNote → 

EndNote Help，也可開啟線上輔助說明。 

� 客戶服務：與國外 Thomson Reuters 出版社直接聯繫 

(1) Sales Information 

Phone: 1 800 722 1227 (Toll Free) 

Phone: 760 438 5526 (country code is 01) 

Fax: 760 438 5573 (country code is 01) 

Web/Email: http://www.endnote.com/contact 

(2) Customer Support (Orders, Billing, and Shipping) 

Phone: 800 336 4474 (country code is 01) 

Fax: 215 386 2911 (country code is 01) 

Web/Email: http://www.endnote.com/contact 

� 客戶服務：與國內代理商碩睿資訊有限公司聯繫 

(1) 客戶服務 

電話：(02)8226-8587 

Email：services@customer-support.com.tw 

(2) 公司網站：http://www.sris.com.tw 

� 技術支援 

當您使用 EndNote 遭遇問題時可聯絡技術支援。當您連絡時，請清楚描述

問題和目前使用之 EndNote 版本、Windows 系統、Word 等版本。開啟

EndNote，點 Help 選單，選擇 About EndNote，即可了解目前使用 EndNote

的版本。 
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與國外與國外與國外與國外 Thomson Reuters 出版社直接聯繫出版社直接聯繫出版社直接聯繫出版社直接聯繫 

(1) 透過Web/Email或電話聯絡，請見： 

http://endnote.com/contact 

與碩睿資訊有限公司聯繫與碩睿資訊有限公司聯繫與碩睿資訊有限公司聯繫與碩睿資訊有限公司聯繫 

(1) 透過Email或電話聯絡： 

Email：services@customer-support.com.tw 

電話：(02)8226-8587 

(2) 公司網站：http://www.sris.com.tw 

� EndNote 網頁 

EndNote 官網 (http://endnote.com) 包含支援小工具、資料轉檔效益與

EndNote 最新版本資訊。您也可在官網的 Training 下看到各種不同類型之

教育訓練課程與文件；在官網的 Downloads 下載更新的 Styles、Filters、

Connections、Templates、試用版等檔案。另外，您也可從 EndNote 的 Help

選單，選擇 “EndNote Program Updates”進行更新。 

� EndNote 討論區 

如果您想參加 EndNote 使用者的討論區，可到 EndNote 官網 

(http://endnote.com) ，點選 Support 選單，選擇 Join the User Forum，即

可進入討論區，檢索、瀏覽相關議題，或參與相關的議題討論。或是您也可

以直接連結討論區網址

http://community.thomsonreuters.com/t5/EndNote/ct-p/endnote 。 

� EndNote 社群網站 

http://www.facebook.com/EndNote 

http://www.twitter.com/EndNoteNews 

http://www.youtube.com/endnotetraining 
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EndNote X7 新功能新功能新功能新功能 

EndNote X7 版，新增了下列功能： 

� 可設定PDF自動匯入資料夾，並自動帶入資料夾階層做為Group標籤及自動

分類。 

� 使用者可以自行設定使用特定欄位的資料作為PDF的檔名。 

� 在PowerPoint插入引用文獻(適用於Windows版) 。 

� 可在Output style中或是Microsoft Word中將參考文獻清單利用Category 

Bibliography進行分類 。 

� 新增文獻類型：Podcast、Press Release、Interview，並調整Conference 

Paper、Blog、Data Set、Thesis和Manuscript的欄位。 

� 您可以在Library中拖曳並移動欄位。 

� 加強同步功能，讓同步可在背景執行。 

� 可同步Share Groups。 

� 加強Quick Search快速檢索功能，能夠查詢PDF以及PDF註記資料  

� 設定 Read/Unread 狀態。 

� 在 Change\Move\Copy Fields 中新增可複製 record number 欄位資料到其

他欄位。 

� 程式自動檢查更新。 
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第一章第一章第一章第一章：：：：EndNote 安安安安裝裝裝裝 

安裝安裝安裝安裝 EndNote 前前前前 

程式需求程式需求程式需求程式需求 

� 系統需求： 

Windows XP，with Service Pack 3 (32 位元或 64 位元版本) 

Windows Vista  (32 位元或 64 位元版本) 

Windows 7 (32 位元或 64 位元版本) 

Windows 8 (32 位元或 64 位元版本) 

� 硬體需求：個人 PC 需在 Pentium 450 MHz 以上、256 MB 以上的記憶體、

至少 180 MB 以上的硬碟可用空間。 

� 如果需使用 Online Search 功能檢索線上網站或資料庫的功能，也需要有安

裝支援網路連結的瀏覽器。 

文書處理軟體文書處理軟體文書處理軟體文書處理軟體 

Windows 系統的 EndNote 可支援： 

� 支援 Microsoft Word 以及 PowerPoint 2007、2010 及 2013。 

� 支援自 OpenOffice.org 文書處理軟(Writer)所建的 Open Document 

Format(ODT)格式檔案。 

� 支援其他文書處理軟體（包含 Microsoft Word, WordPerfect, 

OpenOffice.org Writer, StarOffice,與 WordPad）所建之 RTF 檔。 
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Microsoft Word：：：： 

安裝EndNote 的Cite While You Write功能會結合在Microsoft Word底下。Word 

2007、2010 及 2013 直接呈現一個 Cite While You Write 欄位於介面上。您可透

過「Cite While You Write 功能」在 Word 中引用書目、編排引用格式。在您安

裝 EndNote 時就會自動嵌入 EndNote 在您的 Word 文書處理軟體中，所以請先

安裝好您的 Microsoft Word，再安裝 EndNote，才不會產生錯誤。 

Microsoft PowerPoint：：：： 

安裝 EndNote 的 Cite While You Write 功能會結合在 Microsoft PowerPoint 底

下。PowerPoint 2007、2010 及 2013 直接呈現一個 Cite While You Write 欄位

於介面上。您可透過「Cite While You Write 功能」在 PowerPoint 中引用書目、

編排引用格式。在您安裝 EndNote 時就會自動嵌入 EndNote 在您的 PowerPoint

簡報處理軟體中，所以請先安裝好您的 Microsoft PowerPoint，再安裝 EndNote，

才不會產生錯誤。 

OpenOffice.org Writer：：：： 

EndNote 已能支援第 3.x 版 OpenOffice.org 文書處理軟體之使用，並且主動產

生一個 EndNote 選單。您也可在 OpenOffice.org 的文書處理軟體上利用 Cite 

While You Write 功能引用參考文獻、產生參考書目清單，套用不同的書目格式。

為了讓 EndNote 能適當地應用於您 OpenOffice.org 文書處理軟體，安裝

EndNote 前應先安裝好 OpenOffice.org 第 3.x 版之文書處理軟體(以下簡稱

Writer)；且在安裝時，務必關閉所有 OpenOffice.org 應用軟體（含 OpenOffice.org

的快速開啟功能(Quickstarter)，位於右下角之功能列上的 Quickstarter 圖示，才

能正常安裝）。 

RTF 和和和和 ODT 文件文件文件文件：：：： 

若非 Word 2007、Word2010、Word2013 以及 OpenOffice.org 第 3.x 版的文書

處理軟體，請就撰寫好的文章（含文章中的引用文獻），儲存成 RTF 檔（亦即

ODT 文件以外的檔案格式），然後透過 EndNote 格式化文件功能，自您 ODT 和

RTF 檔就引用與參考書目套用書目格式（格式化）。 

安裝安裝安裝安裝 EndNote 

安裝步驟安裝步驟安裝步驟安裝步驟 

1. 首先確認您登入電腦為具權限管理或具安裝程式的使用者身份，確認防毒軟

體、Microsoft Word、Microsoft PowerPoint 或 OpenOffice.org 等沒有正在

執行程式，例如 OpenOffice.org 的快速啟動(Quickstarter)會影響安裝程式，

需先關閉 Quickstarter 之執行。 

2. 從貴單位網頁上下載 EndNote X7 壓縮檔案。 
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3. 解壓縮該檔案後會出現：ENX7Inst.msi(安裝程式)和 License.dat(合法授權安

裝檔)，請將這兩個檔案放在同一資料夾放在同一資料夾放在同一資料夾放在同一資料夾內內內內： 

 

4. 點選 ENX7Inst.msi 開始進行安裝，安裝前請先關閉安裝前請先關閉安裝前請先關閉安裝前請先關閉 Word 和和和和 PowerPoint，

待出現 “Welcome to the EndNote X7”畫面，按下”Next >” 
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5. 出現 “EndNote X7 Volume License Version”，按下 Accept> 

  

6. 出現 “Read Me Information”，按下”Next >” 

 

 

單位名稱 

單位號碼 
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7. 出現 “End User License Agreement”，選擇 “I accept license agreement”

後，按下 “Next >” 

 

8. 出現 “Select Installation Type”，請選擇 Custom，再點選 “Next >” 
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9. 出現 “Select Destination”， 預設儲存路徑於 C:\Program File\EndNote X7，

請按 “Next>”  

 
10. 出現 “Select Features”視窗  
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11. 請依照下圖點選後，請按 “Next>” 
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12. 確認 “Additional Connections”、” Additional Filters”及” Additional 

Styles”前的”X”消失後，請按”Next>” 

 

13. 出現 “Ready to Install the Application”，請按 “Next>” 
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14. 出現 “Updating System” 和 “Current Operation”，請稍待片刻。 

 
15. 出現 “EndNote X7 has been successfully installed”畫面，按下 “Finish”完成

安裝。 
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若若若若已安裝完已安裝完已安裝完已安裝完 EndNote X7 後後後後，，，，欲更改欲更改欲更改欲更改 EndNote 安裝元件安裝元件安裝元件安裝元件 

1. 請先依管理者或安裝程式管理者之使用權限登入作業系統。 

2. 啟動安裝執行程式；或至 Windows 開始選單，點「控制台」，選擇新增或移

除程式＞點 EndNote X7，按「變更」。 

 
 

 

3. 出現 “Application Maintenance”對話框，請點“Modify”安裝選項。 
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4. 出現下圖“Select Features”對話框，可依各選項功能與特色，決定哪一

“Features”是否選擇安裝，再按“Next>” 

 

選擇元件項目選擇元件項目選擇元件項目選擇元件項目 

您可依上圖畫面主要幾個 EndNote 分類元件點選、安裝，這些元件包括： 

1. EndNote Application 

� EndNote Program 

� Sample Files 

� EndNote Help 

� Getting Started Guide 

2. Word Templates/Add-ins: 

� Templates for Microsoft Word 

� Cite While You Write for  Microsoft Word 

3. OpenOffice.org Extension 

4. Additional Connections 
其他的 Connections files 可以直接從線上資料庫或網站取得，他們會依資訊

服務提供單位進行群組、分類。 

5. Additional Filters 
其他的 Filters 亦是依資訊服務提供單位群組、分類。 

6. Additional Styles 
額外其他的 Styles 格式依種類群組、呈現。 
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7. Spelling Dictionaries 
EndNote 所提供的拼字檢查字典功能。 

8. 出現“Ready to Modify the Application”對話框，請按“Next>”，進入系統安裝

畫面；請稍待安裝畫面完成即可。 

EndNote 安裝資料夾路徑安裝資料夾路徑安裝資料夾路徑安裝資料夾路徑 

� Program Folder 

C:\Program Files\EndNote X7 

C:\Program Files (x86)\EndNote X7 (64-bit Windows versions) 

� Shared Folder 

Windows 7 & Windows 8 

C:\Users\Public\Documents\EndNote 

Windows XP 

Documents and Settings\All Users\Shared Documents\EndNote 

Windows Vista 

C:\Users\Public\Public Documents\EndNote 

� Personal Folder 

Windows 7 & Windows 8 

C:\Users\UserName\Documents\EndNote 

Windows XP 

C:\Documents and Settings\[UserName]\My Documents\EndNote 

Windows Vista 

C:\Users\[UserName]\Documents\EndNote 

� Preferences Folder 

Windows 7 & Windows 8 

C:\Users\[UserName]\App Data\Roaming\EndNote 

Windows XP 

C:\Documents and Settings\[UserName]\Application Data\EndNote 

Windows Vista 

C:\Users\[UserName]\App Data\Roaming\EndNote 

從舊版從舊版從舊版從舊版 EndNote 升級安裝升級安裝升級安裝升級安裝 

在您開始安裝前，如果想保留新設定的書目格式(Styles)，以及客製化之 Import 

Filters、Connection Files，請先備份；在安裝 EndNote X7 前，建議先移除任何

舊版的 EndNote 版本，如何移除舊版 EndNote，請見“移除 EndNote”單元。 
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備份或取代檔案備份或取代檔案備份或取代檔案備份或取代檔案 

如果尚未移除舊版 EndNote 即安裝新版時，會跳出提醒對話視窗並顯示兩個選

項。(不管選擇哪個選項，您原先建立的 EndNote Library 都不會被刪掉。) 

 
� 備份舊有檔案 

若您想保留之前有修改過之 Style、Filter、Connection，您可選擇「Backup 

older files」選項。選擇後 EndNote 會在 EndNote 資料夾中建立一個 Backup

資料夾，並複製所有舊版 EndNote 的 Style、Filter、Connection Files。在

安裝完 EndNote 後，您須自行分別移動此些備份資料夾至 EndNote X7 對

應的 Style、Filter、Connection Files 資料夾中。 

� 移除舊有檔案 

若您選擇「Remove older files」項目，安裝程式將會取代所有舊版 EndNote

中之 Style、Filter、Connection Files。所以，如果您想保留舊有之 Style、

Filter、Connection Files，請不要選擇此項目，以免格式檔案被覆蓋。 

 

 

開啟和轉換舊有開啟和轉換舊有開啟和轉換舊有開啟和轉換舊有 EndNote Libraries 

EndNote X7 能自動轉換和開啟 EndNote 8 版本以後的 Library。 

 

轉換舊有轉換舊有轉換舊有轉換舊有 EndNote Library 

1. 開啟 EndNote 

2. 從 File→Open→Open Library 

3. 開啟檔案對話框選擇舊有的 Library 儲存路徑，點選開啟。 

4. 此 Library 即以新版的 EndNote 程式開啟。 

注意：一旦您已經自 EndNote X7 開啟和使用 Library 後，則該 Library 只能用在

EndNote X(10 版)及 X(10 版)以後的版本。 

使用舊使用舊使用舊使用舊 Style、、、、Filter、、、、Connection Files 

EndNote X7 可以使用從 EndNote 4.01～X4 版所建立客製化的 Styles、Filters、

Connection Files。一旦您在 EndNote X7 中編輯過這些檔案並存檔，這些檔案

將自動轉換成最新版本，並於 EndNote 8 之後的版本開啟。 
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檢查安裝檢查安裝檢查安裝檢查安裝 

確認確認確認確認 EndNote 

從開始→程式集→EndNote→EndNote Program。開啟 EndNote 程式後，會出

現您是否要登錄或建立一個 EndNote web 帳號。若選擇 Cancel 後，會出現三

個選項的對話框；您可選擇建立新的或打開一個舊有的 EndNote Library。 

確認確認確認確認 Cite While You Write 的安裝的安裝的安裝的安裝 

要檢查 Cite While You Write 是否安裝正確，請開啟 Word、OpenOffice.org Writer

或 PowerPoint。 

 
在 Word 2007、Word 2010 或 Word 2013 您可看工具列上出現 EndNote X7 標

籤與其下選項功能。 

 
 
在 OpenOffice.org Writer，您可直接看到一個 EndNote X7 功能選單。 
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在 PowerPoint 2007、PowerPoint 2010 或 PowerPoint 2013 您也可看到 

EndNote X7 標籤與其下選項功能。 

 
 
若先安裝 EndNote 後才安裝（更新）Word 或 PowerPoint，則不會出現 EndNote 

X7 功能列；若 Word、PowerPoint 或 OpenOffice.org Writer 看不到 EndNote X7

功能列，請先關掉相關 Microsoft Office 或 OpenOffice.org 系列的應用軟體（含

QuickStarter）；然後在有系統管理或安裝程式權限下，點「開始」→「控制台」

→「新增或移除程式」→選擇「EndNote X7」然後按「變更」→選擇「修復」、

「下一步」進行功能修復動作。 

 

移除移除移除移除 EndNote 

備份備份備份備份 EndNote 

建議在移除 EndNote 前，請先備份您利用 EndNote 所作的任何客製化檔案。例

如新增的書目格式。請至 My Documents\EndNote\Styles 的路徑下，將您自製

的所有書目格式檔案複製一份，等安裝好新版的 EndNote，在儲存至 C:\Program 

Files\EndNote X7\Styles 的路徑下。 

 

移除移除移除移除 EndNote 

請至控制台→新增移除程式→EndNote X7→選擇移除，即可移除 EndNote X7

程式。 
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移除任何修改過的移除任何修改過的移除任何修改過的移除任何修改過的 EndNote 客製化檔案客製化檔案客製化檔案客製化檔案 

EndNote 預設移除程序不會移除客製化檔案(Filter、Style 等)，您可以自行手動

刪除，客製化檔案存取位置路徑如下。 

Windows XP 

C:\Program Files\EndNote X7 

C:\Documents and Settings\All Users\Shared Documents\EndNote 

C:\Documents and Settings\[UserName]\My Documents\EndNote 

C:\Documents and Settings\[UserName]\Application Data\EndNote 

Windows Vista 

C:\Program Files\EndNote X7 

C:\Users\Public\Public Documents\EndNote 

C:\Users\[UserName]\Documents\EndNote 

C:\Users\[UserName]\App Data\Roaming\EndNote 

Windows 7 

C:\Program Files\EndNote X7 

C:\Users\Public\Public Documents\EndNote 

C:\Users\[UserName]\Documents\EndNote 

C:\Users\[UserName]\App Data\Roaming\EndNote 

注意：如果您是使用 Windows 64 位元電腦，您的 EndNote 程式資料夾路徑會

在 C:\Program Files (x86)\EndNote X7 

 

相關章節相關章節相關章節相關章節 

有關本章之介紹，亦可瀏覽 EndNote Help 下之 Search for Help on…資訊中的： 

�  About Mass Program Installations 

�  Custom Installations 
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第二章第二章第二章第二章：：：：EndNote Library 介紹介紹介紹介紹 

本章節包含基本的操作 EndNote。您將學到： 

� 開啟 EndNote 和建立 EndNote Library 

� 介紹 EndNote Library 視窗 

� 預覽、排序及修改參考文獻 

� 查找 EndNote Library 中的書目 

� 離開 EndNote 程式 

啟用啟用啟用啟用 EndNote  

新新新新建立個人的建立個人的建立個人的建立個人的 Library 

1. 欲新增一個自己的Library，請點選「Create a new library」。 

 

2. 預設的檔名為「My EndNote Library.enl」，您可以更改檔名，並選擇儲

存路徑。 
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開啟開啟開啟開啟已存在的已存在的已存在的已存在的Library(以以以以Sample Library為例為例為例為例) 

1. 從開始→程式集→ EndNote→ EndNote Program。第一次使用時，會出現 

“Getting Started with EndNote”對話視窗，供您選擇。 

 

提醒：如果設定預設Library自動開啟，則會直接開啟Library而不是上面這個對

話框。若發生此狀況，可關掉Library，至File→Open→Open Library進行設定。

或是點選Help→Getting Started with EndNote。 

 

2. 請點圖示“Open an existing EndNote library” 
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3. 在檔案對話方框中，開啟EndNote內建的Example library作練習。 

♦ 點選“C:\”→點選Program Files資料夾→EndNote X7資料夾→點選

“Examples”捷徑，然後開啟。 

♦ 在開啟 “Examples”畫面底下，請點選Sample_Library_X7.enlx，會解

壓縮出 “Sample_Library_X7”Library與“ Sample_Library_X7.Data資

料夾”，系統直接開啟EndNote reference library目錄下的

Sample_Library.enl範本檔案。 

 
 
 

the compressed library 

the uncompressed library 
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EndNote Library 視窗介紹視窗介紹視窗介紹視窗介紹 

視窗介紹視窗介紹視窗介紹視窗介紹(EndNote Panels) 

開啟Sample Library，您會在EndNote Library視窗介面，看到視窗包含三個部

份，如下所示。 

 

 
1. 參考書目清單視窗(Reference List Panel) 

中間視窗的上半部是查詢書目或檢索線上資料庫的視窗，下半部呈現參考文

獻清單，顯示多個欄位；預設第一欄是已閱讀或未閱讀的註記、第二欄是以

迴紋針顯示該筆參考文獻書目是否有附加檔案。接著為第一作者的姓名

(Author)、年代(Year)、標題(Title)、星號等級(Rating)、期刊名稱(或第二標

題)、參考書目類型(Reference Type)、網址(URL)和最後更新日期(Last 

Updated)。 

2. 群組視窗(Groups Panel) 

視窗左方呈現參考資料之不同群組分群，方便您直接組織管理參考文獻。 

3. 分頁視窗(Tabs Panel) 

EndNote Library右方的分頁視窗有三個：第一個是Reference，可以修改和

編輯書目資料；第二個是Preview，可預覽每筆書目的格式；第三個是Attached 

PDFs可針對有夾帶PDF檔的全文進行預覽和編輯。 

群組視窗(Groups Panel) 

參考書目清單視窗(Reference List Panel) 

分頁預覽視窗(Tabs Panel) 查詢視窗(Search Panel) 
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� 您可自行調整視窗和欄位的寬度。 

 
 

� 您亦可利用拖曳的方式移動欄位 

 
 

 

可自行調整視窗和欄位至方便瀏覽的寬度 

插入位置為

藍線前方 
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視窗視窗視窗視窗面面面面版版版版介紹介紹介紹介紹(Window Layout) 

點選右下角的Layout，可以調整Groups Panel和Reference Panel的面版配置，

自行選擇您喜愛的面版呈現方式。如：切換成Botton-Split的模式。(如下圖) 

 

預覽參考預覽參考預覽參考預覽參考書目書目書目書目 

您可以透過Tab視窗之Preview區塊，看到您點選之參考書目資料內容。 

1. 如果在EndNote Library視窗中沒有看到Tab視窗，第一個步驟請調整

Layout>Reference Panel>切換成Botton-Spilt的模式，開啟Preview預覽視

窗。 

2. 本範例，請點「Bat Conservation International」這筆參考書目，我們在預覽

視窗中即可看到該筆參考文獻所呈現之書目格式（output style）。EndNote

的output style是依不同期刊或其他出版商所建立的（或經這些期刊出版商所

要求的特定格式）；這個Style決定列印、輸出、預覽和建立參考文獻清單時

呈現之樣式。 

3. 如欲選擇不同格式，可從工具列的下拉選單中選擇輸出格式；例如選擇APA 

6th格式。 
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提醒：預覽視窗中只會顯示一筆參考文獻；如果選擇多筆參考文獻，也只會呈現

第一筆選取之文獻；當選擇不同書目格式，即改變其在預覽視窗中呈現之格式。 

參考參考參考參考書目書目書目書目排序排序排序排序 

參考文獻可以簡單的點選欄位標題作排序（如依作者、年代、標題排序）。排序

步驟如下： 

1. 點一下「Author」欄（作者），改變當下作者的排序方式，從依照字母遞增或

遞減排序。 
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2. 點一下年代(Year)標題欄，視窗中的參考文獻將依年代遞增排序。再點一下

年代的標題欄，視窗中的參考文獻則改為依年代遞減排序。 

 
3. 再點選作者，視窗中的參考文獻則重新再會依作者名稱(字母順序)排序。 
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選擇和開啟一筆參考選擇和開啟一筆參考選擇和開啟一筆參考選擇和開啟一筆參考書目書目書目書目 

點選欲開啟的參考文獻，可分別透過滑鼠點選、鍵盤鍵入(Enter鍵)、直接點選

要查找的欄位（例如作者），鍵入要查找的前幾個字母（作者名稱的前幾個字

母），即會跳至符合該作者名稱字母開頭之書目上等，多元之開啟書目資料方

式。 

快速找到和呈現參考文獻快速找到和呈現參考文獻快速找到和呈現參考文獻快速找到和呈現參考文獻 

1. 當直接鍵入 “sch”字母即可找到作者為 Schloegl 的參考書目，經點選該

筆參考書目後，您可瀏覽、編輯、複製、剪下、刪除選取的該筆書目。 

 

2. 點選單筆參考書目，直接按鍵盤 Enter 鍵或滑鼠左鍵快點兩下，即可開

啟、進入編輯畫面。 

3. 開啟參考書目後，會出現該筆參考書目之編輯視窗，在此可看到完整著錄

資料。也可自行鍵入資料。 
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4. 視窗上方的標題列，出現 “Schloegl, 2012 #2304” 是EndNote用於Library

查找這筆引用文獻的系統紀錄碼，諸如在Word中被引用的作者是誰、哪

一年以及引用編號。 

5. 在瀏覽參考文獻時，可以利用滑鼠下拉捲軸、上移，或是利用TAB鍵往前，

利用SHIFT+TAB鍵往後。 

6. 勾選Show Empty Fields顯示參考文獻的空白欄位。 

7. 勾選Show Rating Filed顯示評分欄位。 

關閉參考關閉參考關閉參考關閉參考書目書目書目書目 

1. 點選視窗右上角的  (Close），即可關閉參考文獻視窗。 

2. 或從 File 選單選擇 Close Reference (或快速鍵Ctrl+W指令)直接關閉參

考文獻視窗。 

可勾選是否要顯示 

1.參考書目中的空白欄位

(Empty Field) 

2.評分欄位(Rating Field) 

為關閉此筆

書目資料按鈕 
標題列 

資料欄位 
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3. 若您有更改參考書目資料，在關閉視窗時，會跳出下方視窗，請點選Yes， 

EndNote即會儲存您對該筆參考書目所做的改變。 

 

快速編輯參考快速編輯參考快速編輯參考快速編輯參考書目書目書目書目 

在 EndNote Library 中，使用者點選 Referance 標籤，可以快速編輯想要修改的

參考書目內容。 

1. 反白某筆參考書目。 

2. 點選Referance標籤，即可在欄位中進行編輯、修改。 
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3. 修改完後，點選任一筆參考書目，即會跳出儲存視窗，請按 “Yes”，儲存

您修改完成之書目資料。 

 

 

相關章節相關章節相關章節相關章節 

有關本章之介紹，亦可瀏覽 EndNote Help 下之 Search for Help on…資訊中的： 

�  The EndNote Library 

�  EndNote References 

�  Searching and Sorting in EndNote 

�  Groups 

 

點選欄位可

直接鍵入或

修改內容 
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第三章第三章第三章第三章：：：：設定設定設定設定 EndNote 偏好設定偏好設定偏好設定偏好設定 

在本章節將為您介紹： 

� EndNote Preferences 設定與呈現 

� 設定每次開啟 EndNote 時，開啟預設指定的 Library 

� 改變呈現字型 

� 設定 Read/Unread 狀態 

進入進入進入進入 EndNote Preferences 

從 EndNote 程式點選 Edit→Preferences 

 

設定預設設定預設設定預設設定預設 Library (Default Library) 

您可設定每次執行 EndNote 程式後，自動開啟某個 Library。設定步驟如下： 

1. 從視窗最上方點選 Edit → Preferences 
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2. 跳出 EndNote Preferences 視窗，在視窗左邊的選項中選擇「Libraries」。 
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3. 在 When EndNote starts 下拉選單，請選 “Open the specified libraries” 

 

4. 點 Add Open Libraries，此時 Sample Library (Sample_Library.enl)會出現

在中間方框中，選擇 Sample_Library.enl 後點選“套用”儲存改變。 
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5. 點選確定後，系統會自動儲存並離開 EndNote Preferences 偏好設定視窗。 

 

改變改變改變改變 Library 欄位欄位欄位欄位呈現呈現呈現呈現 

可選擇在參考書目清單視窗(Reference List Panel)所要呈現之欄位 

1. 從視窗最上方點選 Edit → Preferences。 

 

2. 在EndNote Preferences 視窗左邊，點Display Fields選項。 
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3. 下拉選單選擇所要呈現之欄位 

 

4. 亦可更改欄位名稱。 

 
5. 點選“確定”離開 Preferences 對話框。 
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改變改變改變改變 Library 呈現字型呈現字型呈現字型呈現字型 

選擇在 Library 視窗和參考文獻視窗呈現不同字型。 

1. 從視窗最上方點選 Edit → Preferences。 

此處為更改「Volume」

欄位為「卷」之結果 
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2. 在 EndNote Preferences 視窗左邊，點 Display Fonts 選項。 

� 設定「Library」字型，改變 Library 視窗中呈現參考文獻清單之字型與

大小。 

� 設定「General」字型，改變 EndNote 內文字形和大小，例如參考書目

或 Style 視窗)。經設定「General」字型，會改變於預覽視窗之字型大

小，與 EndNote 輸出、列印或複製參考文獻的字體。 

� 設定「Label」字型決定參考文獻編輯視窗欄位標題大小（如下圖所示）。 

� 設定「Search」字型決定使用者在檢索欄位中輸入之字體大小。 
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3. 改變字體與大小之設定，請在 Display Fonts 選項下，分別點選欲更改設定

之分頁標籤，例如上述「Library」、「General」、「Label」、「Search」，然後

按 “Change Font”按鈕。在字型清單中選擇欲改變的字型、字型樣式與大

小，選「確定」進行改變儲存。 

 
4. 最後，再按一次「確定」離開 Preferences 對話框。 

選擇變更字

形、樣式以

及大小 
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設定設定設定設定 Read/Unread 狀態狀態狀態狀態 

Unread狀態，書目資料呈現粗黑體，且前方有 做為標記；Read狀態，書目資

此處為改「Label」字體為

20pt大小的呈現結果 
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料則呈現細黑體，且前方無 做為標記。 

 

EndNote X7可自定義 Read/Unread 狀態 

1. 點選 Edit → Preferences。 

 
 

 
2. 在 EndNote Preferences 視窗左邊，點 Read/Unread 選項。 
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3. NEW!!Read可設定三種狀態： 

� Mark a reference as read upon viewing it in a stand-alone Reference 

window：只有自行將 改為 或是點兩下該筆書目資料才會變成 Read

狀態。 
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� Mark a reference as read upon viewing it in the Reference, PDF, or 
Preview within the Library window.：只要在 Reference, PDF, Preview

三個視窗之一閱讀該筆書目之資料即會變成 Read 狀態。 

 

 

� Mark a reference as read upon changing its rating.：只要改變 Rating

星星數即會變成 Read 狀態。 
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相關章節相關章節相關章節相關章節 

有關本章之相關介紹，可瀏覽 EndNote Help 下之 Search for Help on…資訊中

的 Preferences。 
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第第第第四四四四章章章章：：：：手動新增手動新增手動新增手動新增參考書目參考書目參考書目參考書目 

在此章節您將學到： 

� 在Library中新增參考文獻 

� 在參考文獻中插入圖片和檔案 

開啟開啟開啟開啟 Sample Library 

請開始執行 EndNote 程式，並開啟 C:\Program Files\EndNote 

X7\Sample_Library_X7 檔案，以利參考本章說明。 

 

利用下列方法可新增參考文獻： 

♦ 在Reference視窗中直接鍵入參考文獻。(請見本章) 

♦ 透過EndNote線上查詢資料庫文獻並匯入。(請見第五章) 

♦ 自線上資料庫查得參考文獻，並下載成純文字檔匯入EndNote。(請見第六

章) 

♦ PDF匯入。(請見第七章) 

手動建立新手動建立新手動建立新手動建立新的參考書目的參考書目的參考書目的參考書目 

1. 選擇工具列中的 References 選單→ New Reference，跳出 New 

Reference 的空白視窗(或是點選上方的快捷鍵 )。 
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2. 新參考文獻視窗預設的資料類型為 Journal Article，您可從參考文獻下拉選

單中選擇您所欲新增的參考文獻類型(Reference Type)。 

 
3. 本範例之文獻類型為 “書籍”，故應從 Reference Type 下拉選單中選 

“Book”。 

請先點下拉選單選擇手

邊所參考的文獻類型 



 

 

51 

 

4. 本範例從輸入作者名稱開始，建立一筆新的書目資料： 

5. 輸入作者姓名 

（1） 作者姓名有兩種呈現方式 

� 名在前，姓在後，如：Tiberius Rex 

� 姓在前，名在後，如：Rex, Tiberius 

（2） 輸入第一位作者，以 Tiberius Rex 為例 

輸入 Tiberius Rex 時，EndNote 採用「Term Lists」功能，會主動對應 Library

是否已建立過此人名，並提供相似名稱建議；由於 Sample Library 中並未

收錄這個作者資料，故介面會以紅色呈現 “Tiberius Rex”之人名。在儲存

這筆參考文獻後，EndNote 會將您所鍵入之作者名稱加到 Sample Library

的作者名稱清單(Term List)中，此後，作者名稱將會以黑色字體呈現。 

 
（3） 輸入第二位作者，以 Bates, P.為例 

在第一位作者名字後方，按下鍵盤上的 Enter 鍵，換至下一行，再輸入第

二位作者名。當您輸入 Bates, P. 時，由於在 Sample Library 中已經收錄

選擇參考文獻類型為：

Book (書籍)。 

紅字表目前 Sample Library

中尚未建立過“Tiberius 

Rex” 
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該作者名字，故輸入“Bat”字母時，EndNote 即會自動列出對應 Bates

開頭的「Bates, P.」完整人名，此時可直接按 Enter 採用 EndNote 所建議

的對應名稱。 

 

（4） 輸入第三作者，例如以 de Young, John Robert, Jr.為例 

第一個逗點前的為作者的 “姓”，第二個逗點前放名字，對於 Jr.( junior

的縮寫)這種名字後面的稱謂或頭銜請放在最後面，讓 EndNote 知道 Jr.

不是作者名稱的一部份。當輸入此作者名稱時，出現 De 開頭建議的名

稱出來，因該名稱並不是您要輸入的人名，且 de 變 De 開頭，請按清

除鍵(Baskspace)，即會更正為 de。 

 
 

 

 
（5） 第四位作者以團體作者（corporate author name）為例 

像團體作者，University of California,, Berkeley，得多加一個逗點表示

沒有 “名字”(first name)了，以供 EndNote 識別這不是一般個人作者名

稱，而是團體名稱。 

按清除鍵(Baskspace)後再

繼續輸入 
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6. 輸入年代及其它資料 

(1) 用滑鼠移動到下一欄位，或使用 TAB 鍵移到 Year 年代一欄，輸入 2006 

(2) 您可以使用滑鼠移動到要編輯的欄位，用 TAB 鍵往下移或 Shift+TAB 鍵

往前移動，繼續在其他欄位中輸入資料，各欄位資料如下；沒有要輸入

資料的欄位請保持空白即可： 

Title: Impacts of meteorites on Earth 

Place Publisher: New York 

Publisher: Blackcourt Press 

Number of Pages: 100 

Abstract: The impact of a meteorite hitting earth millions of years ago 

may have led to the extinction of some marine life. 

 

 

由於這本書沒有Series Title 和 

Series Editor兩項資料，所以這兩個

欄位就保持空白。 
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在參考文獻中加入在參考文獻中加入在參考文獻中加入在參考文獻中加入檔案檔案檔案檔案 

7. 不論哪一文獻類型，皆固定有 File Attachments 、Figure 這兩個可以夾帶

檔案和圖表的欄位。 

（1） 欲夾帶檔案，請找到 File Attachments 欄位→按右鍵出現選單→File 

Attachments→Attach File→跳至一個選擇檔案的對話方塊(或是點

選上方的 ) 

 

 
（2） 請選擇 C:\Program Files\EndNote X7，然後點選

EndNoteX7WinHelp.pdf 
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（3） 請注意要勾選該對話方塊最下方之 “Copy this file to the default 

file attachment folder and create a relative link.”這個選項，以確保

您所選的這個檔案會被 EndNote 儲存一個檔案複本，以利這個檔

案能隨著您儲存的 EndNote Library 檔移動。 

（4） 選擇 EndNoteX7WinHelp.pdf 檔，點選「開啟」後，會自動預覽

PDF 內容，此時只要點選上方之“Reference”標籤，即會回到書

目資料欄位。在上列圖示上，快點兩下 pdf 檔案圖示，即可開啟 pdf

檔。 
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提醒：每一筆書目資料最多可夾帶 45 個檔案，不限格式(pdf,word,excel…)。 

8. 當您完成所有欄位編輯後，關閉編輯視窗，EndNote 即會自動儲存資料；

並看到它存在 Library 清單中。 
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9. 關閉編輯的參考書目後，發現還想再更改書目內容，可在該筆書目上，快速

點擊兩下，開啟編輯視窗檢視其所有著錄內容。按視窗關閉鈕「Close」，即

又回到瀏覽參考文獻的清單視窗。在參考文獻前面，最前方的標題欄中出現

圖示，即可知道該筆參考文獻的 File Attachments 欄位有插入檔案。 

在參考文獻中加入圖片在參考文獻中加入圖片在參考文獻中加入圖片在參考文獻中加入圖片 

若文獻有相關圖表，希望能附加在該筆書目上，但每一筆參考文獻只能夾帶一

個圖片檔。圖片檔案和物件檔案之界定如下： 
 
以下為圖片檔案之延伸解釋： 
� BMP  Windows Bitmap 
� GIF   Graphics Interchange Format 
� JPEG  JPEG File Interchange Format 
� PNG  Portable Network Graphics 
� TIFF  Tag Image File Format 

 
您也可以插入物件檔案，所謂之物件檔，包括： 
� Audio files (WAV, MP3) 

� Microsoft Access files 

� Microsoft Excel files 

� Microsoft Power Point files 

� Microsoft Project files 

� Microsoft Visio files 

� Microsoft Word files 

� Multimedia files (MOV, QuickTime) 

� Technical drawing files 

� Text files (TXT, RTF, HTML) 

 
以下為插入圖片之相關步驟： 

1. 在 All References 中，雙點擊“Tool use and physical cognition in birds and 
mammals”此筆參考書目。 

2. 選擇 Figure 欄位，按右鍵→選擇 Attach Figure。(或是點選     ) 
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3. 在出現的 Attach Figure 視窗中 

（1） 點選 Choose File 開啟 C:\Program Files\EndNote X7\Examples 資料

夾 

 
（2） 選擇 Feather2.BMP 檔，並開啟。 
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（3） 在 Figure 欄位中可以看到插入的 Feather2.BMP 圖檔，並請在 Caption

欄位輸入 Cockatiel Crest Feathering，以作為圖片說明，由於附加之圖

片可被引用在 Microsoft Word 中，屆時需要以此文字而查詢到該圖片。 

 
4. 關閉視窗時，系統會跳出是否儲存的視窗，請按 Yes，儲存資料並且回到

Sample Library 視窗。 
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新建一筆其他資料類型之新建一筆其他資料類型之新建一筆其他資料類型之新建一筆其他資料類型之參考文獻參考文獻參考文獻參考文獻(以以以以 Excel 檔為例檔為例檔為例檔為例) 

1. 選擇工具列中的 References 選單→ New Reference，跳出 New 

Reference 的空白視窗(或是點選上方 )。 

 
2. 在 Reference Type 的下拉選單中選擇 Chart or Table 
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3. 在年代、標題等欄位中輸入以下資料： 

Created By: Milkirk, Marie 

Year: 2002 

Title: Hominid Timeline 

Image Source Program: Microsoft Excel 

Date: May 9 

Keywords: Evolution 

Hominids 

Timelines 

Abstract：：：：This article discusses the evolution of bird feathers from reptilian 

scales. 

 
4. 選擇 Figure 欄位，點選右鍵→Attach Figure 
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5. 此時會跳出 Attach Figure 視窗 

(1) 點選 Choose File 開啟 C:\Program Files\EndNote X7\Examples 資料夾 

 

(2) 選擇 Hominid Evolution.xls 並開啟該檔案，之後點選 OK 插入檔案 
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(3) 在 Reference 中可看到剛剛所插入的 Hominid Evolution.xls，並在

Caption 欄位中輸入 Hominid Timeline 作為此檔說明。 

 

6. 當關閉書目編輯視窗前，請點選 File→Save 儲存資料，再關閉視窗，回到

Sample Library 視窗。 

 

檢視檢視檢視檢視 Reference 欄位欄位欄位欄位 

NEW!!Reference 視窗中會顯示書目資料匯入時的資料，或是使用者自行鍵入的

資料。但通常不是所有的欄位中都有資料，因此您可以選擇 來顯示呈現的
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欄位。若選擇 Show Empty Fields 則會顯示該資料類型下的所有預設欄位，以下

圖為例，其資料類型為 Journal Article，因此下方會顯示所有 Journal Article 預

設的欄位，不管該欄位是否有鍵入資料，都將呈現出來。

 
若不勾選 Show Empty Fields，則不會顯示欄位中沒有鍵入資料的欄位 

空的欄位(沒有

鍵入資料) 
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若勾選 Show Rating Field 選項，則 Rating 欄位會顯示出來，若不勾選，則 Rating

欄位會隱藏起來。 

 

相關章節相關章節相關章節相關章節 

有關本章之相關介紹，可瀏覽 EndNote Help 下之 Search for Help on…資訊中 

�  EndNote References 

�  Reference Types 



 

 

66 

第五章第五章第五章第五章：：：：搜尋線上資料庫搜尋線上資料庫搜尋線上資料庫搜尋線上資料庫 

在EndNote進行線上資料庫搜尋參考書目的查詢方式，就如同我們在EndNote 

Library查找書目資料一樣簡易；而且查得之檢索結果，可直接匯入EndNote 

Library中。 

 

本章您將學到下列基本步驟： 

� 連結線上資料庫 

� 檢索並下載參考書目至EndNote Library 

� 利用“Find Full Text”功能查找參考書目全文檔 

進行本章節前，請連上網路。 

關於關於關於關於PubMed資料庫資料庫資料庫資料庫 

本章節，您將連到美國National Library of Medicine提供之線上免費使用

MEDLINE版本資料庫，其名稱叫PubMed。 

開啟開啟開啟開啟Sample Library 

請執行 EndNote 程式，並開啟 Sample Library 範例檔。 

切換操作視窗切換操作視窗切換操作視窗切換操作視窗 

至 Library 視窗左邊區塊，可選擇下列三種呈現模式，分別是：Integrated Library 

& Online Search Mode、Local Library Mode 或 Online Search Mode。 

這三種呈現模式中，主要是兩種使用 EndNote 模組概念： 

1. Local Library 模式：在此模式之下會顯示個人群組(Custom groups)、智慧

群組(Smart groups)和組合群組(From groups)；但是不會顯示線上群組

(Online Groups )，以避免搜尋的參考文獻顯示在此模式之下。這是預設的模

式。 

2. Online Search 模式：在此模式之下僅會顯示 Online Search groups，可以在

此模式之下查詢和下載找到之參考書目，從 EndNote 線上資料庫匯入的參考

書目會先暫存在此模式中，一旦關閉 EndNote，參考書目就會被移除。 

3. Integrated Library & Online Search 模式：此模組包含所有 Local Library 模

式和 Online Search 模式下的所有群組，從線上資料庫下載的參考書目會顯
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示在 Online Search group set中。 

這三個不同模式之切換，請依個人習慣，點左邊群組區塊上方之三個工具按鈕切

換。 

 

 

 

 

選擇連線資料庫選擇連線資料庫選擇連線資料庫選擇連線資料庫(Online Search) 

1. 從EndNote視窗上方工具列中，選擇Tools →Online Search  

 

 

 

2. 亦或是在Groups Panel中的Online Search區塊，點 “more”呈現資料庫清

單。此區塊會將您選擇過的線上資料庫記憶在左邊Online Search群組下，以

Online Search Mode 

Integrated Library & 

Online Search Mode 

 

Local Library Mode 
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便使用者下次直接點選、查詢；您亦可客製化常查詢之資料庫清單。 

 

3. 出現一個標題為Choose A Connection 的視窗，此視窗顯示所有可連結之資

料庫清單，您可使用Quick Search功能快速查到，以助您更快找到要連結的

資料庫，或透過分類瀏覽、篩選。接下來請選擇“PubMed”後，點Choose。 
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4. 接著會在Groups Panel中的Online Search群組顯示PubMed (NLM)選項，點

擊一下，出現上方檢索視窗，則表示您已連上這個資料庫。 

 

點選 More或是 Less Info開啟或是

隱藏關於此 Connection說明 

可直接輸入資料庫名
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查詢查詢查詢查詢 PubMed 資料庫資料庫資料庫資料庫 

1. 以本範例為例，從查詢視窗欄位下拉選單選 “MeSH Terms”，在後方空白

欄位中輸入“fossil”；對照選單請選擇Contains。 

 

 

 

 

 

2. 點“Search”進行查詢。EndNote會將檢索條件傳至PubMed資料庫進行搜

尋，接下來會出現查得筆數之檢索結果視窗。 

 
3. 若覺得查得筆數太大，可按「Cancel」回檢索畫面，下更精確的檢索條件，

如在第二查詢欄位輸入“trilobite”，並從下拉選單中選擇All Field欄位、對照

下拉選單中選Contains，最後並選擇布林邏輯AND來結合第一個與第二個

檢索條件。 

 

4. 點Search後，EndNote傳送檢索條件到PubMed資料庫，即可發現查詢結果

筆數變少。 

對照選單 
布林邏輯選單 

欄位下拉選單 

檢索詞 
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5. 可依需求，更改欲下載之筆數。以本例，在檢索結果視窗改下載1到10筆；

經點“OK”後，即會看到自PubMed線上資料庫只下載10筆參考文獻。 

 
6. 下載後，在Online Search會看到PubMed資料庫的群組中出現此10筆參考

書目；“All References”亦會增加此10筆參考書目。 

 

但若您是在Online Search模式下操作以上步驟，此10筆參考書目僅會暫時的顯
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示出來，但不會隨即將此10筆參考書目加入您原先Library的 “All References”

書目中。您必須自行檢視哪些是您需要的書目資料，選取書目後，按滑鼠右鍵，

選擇Add References To→某一個群組中，將書目資料自行作歸類。 

 
一旦您離開此模式到Integrated Library & Online Search模式下，系統會跳出警告

視窗，若選擇確定，則該10筆參考書目資料就會消失。因此請先選擇「取消」，

將需要的參考書目作適當的歸類，再點選「確定」。 

 
若您暫時無法將書目資料作適當的歸類，建議您選擇到Local Library模式下繼續

其它的動作，剛剛在Online Search 模式中所查詢到的資料暫時不會被刪除。 
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檢檢檢檢視視視視參考文獻參考文獻參考文獻參考文獻 

建議仔細檢查每筆參考文獻，並確認這些參考文獻的欄位內容是否正確。您可個

別開啟每篇文獻，或利用Reference快速瀏覽檢視各欄位中的資料。 

 

刪除參考文獻刪除參考文獻刪除參考文獻刪除參考文獻 

在 Integrated Library & Online Search 模式下，從 Online Search 線上資料庫抓

下來的參考文獻會直接匯入 EndNote Library，故如欲刪除不想保留的參考文

獻，其方式如下： 

1. 在PubMed群組，選擇不需要的參考書目。 
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2. 從References選單→選Move References to Trash，選擇的參考書目就會從

Library中移到Trash群組。 

 

3. 若已確認要刪除這兩篇文獻，即可點選Trash群組→按右鍵→Empty Trash。 
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4. 點選 “是”，即會完全刪除這兩篇文獻。 

 
5. 點選All References群組即可回到完整參考文獻清單。 

6. 若您欲再至PubMed查詢其他資料，請點選PubMed群組，輸入其他檢索策

略，點Search。在Confirm Online Search視窗中會再呈現有符合查詢條件

的筆數。若於視窗勾選 “Clear currently displayed results before retrieving 

records”選項，能清除之前暫存在PubMed群組中的資料，但注意此功能只

清除PubMed群組中的文獻，不會影響原本查得之參考書目。 

 

為參考文獻尋找電子全文檔為參考文獻尋找電子全文檔為參考文獻尋找電子全文檔為參考文獻尋找電子全文檔(Find Full Text) 

有些線上資料庫不僅有書目資訊，還可能會有電子全文檔；可藉由下列步驟，

找到電子全文並自動夾帶檔案於對應的書目記錄上。 

1. 請在所有All Reference的畫面，在鍵盤上選擇 Ctral+A 全選目前所有的書

目資料。  
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2. 點選References選單，再點Find Full Text→Find Full Text…。 

 

3. 此時會出現一個宣告著作財權產的對話方塊，點 “OK”後，EndNote即會
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進行線上電子全文查找。 

 

4. 在查找電子全文的過程中，左邊群組下方之Find Full Text區塊會出現一個 

“Searching”群組，顯示正在線上搜尋全文中。此線上搜尋全文是一個背景

處理模式的功能，待查找全文過程，您仍可一邊使用EndNote軟體功能、

直接操作介面。 

 

5. 當線上電子全文檔搜尋完成，Searching Group即會消失，並依Found 

PDF、Found URL或Not found三個類目顯示檢索結果。下圖範例表示其搜

尋結果為：17筆找到PDF全文檔，另30筆找到全文的URL網址，而34筆查

無全文和URL網址。 

 

6. 如欲查閱有找到全文的書目，請點選左方Find Full Text中的Found PDF子

群組，即可查閱有找到PDF全文檔的參考書目。有搜尋到PDF全文檔的該

筆書目前面，會顯示一個已夾帶檔案的迴紋針圖示。 
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7. 若平時有使用PubMed資料庫，可至Edit→Preference→Find Full Text中，

將“PubMed LinkOut”打勾，以後使用Find Full Text尋找全文時，EndNote

就會連線至PubMed資料庫找尋PDF檔案。(預設是沒有打勾的狀態) 

 

相關章節相關章節相關章節相關章節 

有關本章之相關介紹，可瀏覽 EndNote Help 下之 Search for Help on…資訊中

Searching Online Databases 章節。 

有出現紋針圖示表

有夾帶檔案 
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第六章第六章第六章第六章：：：：匯入參考文獻資料至匯入參考文獻資料至匯入參考文獻資料至匯入參考文獻資料至 EndNote 

第五章已介紹如何從 Online Search 直接取得參考文獻，但不是所有資料庫都有

支援此功能。如果您是從線上資料庫、圖書館館藏目錄儲存、下載純文字檔，亦

可透過 EndNote 的 Import Filters 將其中的檢索結果匯入至 EndNote。 

 
此章節您將學習到： 

� 從資料庫網頁直接匯入參考書目 

� 選擇 Import Filter，將純文字檔書目資料匯入至 EndNote 中 

開啟開啟開啟開啟 Sample Library 

請執行 EndNote 程式，並開啟 C:\Program Files\EndNote 

X7\Sample_Library_X7 檔案。 

從從從從資料庫資料庫資料庫資料庫網頁直接網頁直接網頁直接網頁直接匯匯匯匯出出出出參考書目參考書目參考書目參考書目 

部分資料庫提供直接匯入選項。至資料庫查詢完資料後，勾選欲匯出的書目資料

後，點選Export、Download、Export Citation、Download Citation等類似字詞的

選項按鈕，即可直接匯入書目資料至EndNote。 

 

※ 在本段以美國National Library of Medicine提供之線上免費使用MEDLINE版

本資料庫，PubMed為例，並以IE 8瀏覽器做示範。 

 

1. 請先至PubMed(http://www.ncbi.nlm.nih.gov/pubmed/)查詢資料。 
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2. 勾選所需之書目資料後，點選右上方的“Send to”。 

 

3. 點選“Citation manager”後，按“Creat File”。 
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� 附檔名為.enw 或.ris的檔案，若跳出檔案下載的視窗，點選 “開啟舊檔開啟舊檔開啟舊檔開啟舊檔””””

即可將書目資料匯入  

4. 書目資料即會自動匯入至EndNote中。在Imported References群組中，即可

看到當次所匯入之書目資料(僅暫存於此)。 

 

 

下表為可直接輸出參考書目並匯入EndNote的資料庫平台清單。(更多參考資訊

請參考EndNote Help下之Search for Help on…資訊中的Direct Export Formats 

and Import Formats章節) 

Information ProviderInformation ProviderInformation ProviderInformation Provider    Type of Data/AccessType of Data/AccessType of Data/AccessType of Data/Access    

ALEPHALEPHALEPHALEPH    Various library Web sites 

American Psychological American Psychological American Psychological American Psychological 

AssociationAssociationAssociationAssociation    

PsycInfo Online 

Subscription required 

Bibliotech.dkBibliotech.dkBibliotech.dkBibliotech.dk    Library Management System 

Bibliotek.dkBibliotek.dkBibliotek.dkBibliotek.dk    Union Catalog 

BioMedCentralBioMedCentralBioMedCentralBioMedCentral    All journals 

Free access 
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Information ProviderInformation ProviderInformation ProviderInformation Provider    Type of Data/AccessType of Data/AccessType of Data/AccessType of Data/Access    

BioOneBioOneBioOneBioOne    Biomedical 

Subscription required 

Blackwell SynergyBlackwell SynergyBlackwell SynergyBlackwell Synergy    All journals published by Blackwell that are online 

BMJBMJBMJBMJ    British Medical Journal; 

Tobacco Control Database 

Free access 

Buffalo UniversityBuffalo UniversityBuffalo UniversityBuffalo University    Library catalog 

Access for Buffalo University students only 

CABICABICABICABI----DirectDirectDirectDirect    CABI Databases 

Subscription required 

Canadian Journal of Canadian Journal of Canadian Journal of Canadian Journal of 

CommunicationCommunicationCommunicationCommunication    

Subscription required 

CCLRCCLRCCLRCCLR    Reference Sight Database provided by the 

University of Waterloo Centre for Contact Lens Research) 

(formerly Bausch  

Free subscription 

DelphionDelphionDelphionDelphion    Patent data 

Subscription required 

EBSCOEBSCOEBSCOEBSCO    All EBSCO databases 

Subscription required 

Ei Engineering VillageEi Engineering VillageEi Engineering VillageEi Engineering Village    Elsevier Engineering Information database 

Subscription required 

ElsevierElsevierElsevierElsevier    Science Direct 

Subscription required 

EMBASEEMBASEEMBASEEMBASE    EMBASE database 

Subscription required 

ERICERICERICERIC    ERIC database 

Free access 
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Information ProviderInformation ProviderInformation ProviderInformation Provider    Type of Data/AccessType of Data/AccessType of Data/AccessType of Data/Access    

EEEESDS GovernmentSDS GovernmentSDS GovernmentSDS Government    Economic and Social Data Service for the UK, 

Government Social Data Survey Information 

Free access 

Google ScholarGoogle ScholarGoogle ScholarGoogle Scholar    Broad literature search 

Free access 

HAPI OnlineHAPI OnlineHAPI OnlineHAPI Online    Hispanic American Periodical Index (UCLA) 

Subscription required 

IEEEIEEEIEEEIEEE    Institute of Electrical and Electronics Engineers, Inc.; All 

databases 

JAMA and ArchivesJAMA and ArchivesJAMA and ArchivesJAMA and Archives    Journal of the American Medical Association 

Free access 

JISCJISCJISCJISC    Joint Information Systems Committee Collections 

Subscription required 

JSTORJSTORJSTORJSTOR    The Scholarly Journal Archive 

Subscription required 

Karger PublishingKarger PublishingKarger PublishingKarger Publishing    Medical and scientific journals 

Free access 

Los Alamos National Los Alamos National Los Alamos National Los Alamos National 

LaboratoryLaboratoryLaboratoryLaboratory    

Library without walls 

Free access 

MicroPatentMicroPatentMicroPatentMicroPatent    All articles 

Subscription required 

NatureNatureNatureNature    Scientific data 

Subscription required 

NeracNeracNeracNerac    All articles 

Subscription required 

NISCNISCNISCNISC    All articles 

Subscription required 
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Information ProviderInformation ProviderInformation ProviderInformation Provider    Type of Data/AccessType of Data/AccessType of Data/AccessType of Data/Access    

OCLCOCLCOCLCOCLC    All databases 

Subscription required 

OhioLINKOhioLINKOhioLINKOhioLINK    Multiple databases 

Subscription required 

OVIDOVIDOVIDOVID    All databases 

Subscription required 

Oxford JoOxford JoOxford JoOxford Journalsurnalsurnalsurnals    Journal articles 

Free access 

Pacific Northwest LabsPacific Northwest LabsPacific Northwest LabsPacific Northwest Labs    Internal databases 

Internal use only 

Patent CafePatent CafePatent CafePatent Cafe    Patent data 

Subscription required 

PILOTSPILOTSPILOTSPILOTS    Medical PTS research 

Internal use only 

PNAS OnlinePNAS OnlinePNAS OnlinePNAS Online    Online science journal search tool at Boston University 

ProQuestProQuestProQuestProQuest    All databases 

Subscription required 

PubMedPubMedPubMedPubMed    U.S. National Library of Medicine (NLM)  

Free Access 

Science MagazineScience MagazineScience MagazineScience Magazine    Journals 

Subscription required 

ScopusScopusScopusScopus    Scopus 

Subscription required 

St. John of God Library & St. John of God Library & St. John of God Library & St. John of God Library & 

Information ServicesInformation ServicesInformation ServicesInformation Services    

Medical library 

Internal use only 

Stanford University’s Stanford University’s Stanford University’s Stanford University’s 

HighWire PressHighWire PressHighWire PressHighWire Press    

HighWire Press 

Free access 
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Information ProviderInformation ProviderInformation ProviderInformation Provider    Type of Data/AccessType of Data/AccessType of Data/AccessType of Data/Access    

WebFeatWebFeatWebFeatWebFeat    Federated Search Engine 

WilsonWebWilsonWebWilsonWebWilsonWeb    General science and social science journals 

Required login 

Web of ScienceWeb of ScienceWeb of ScienceWeb of Science  
1. Go to the All Databases or Web of Science search 

page and perform a search.  

2. From the Results page, select the records that you 

want to export to EndNote. 

3. Go to Output Records section at the bottom of the 

page and select the Full Record radio button in step 

2. 

4. Save the records to Plain Text. 

5. On the Processing page, click the Export button. 

選擇選擇選擇選擇對應對應對應對應的的的的 Import Filter 和匯入和匯入和匯入和匯入書目書目書目書目至至至至 EndNote 

有些資料庫，須將欲匯入的檢索結果存成純文字檔，而此純文字檔並未能就

EndNote格式指引對應的書目欄位，例如在PubMed查得之檢索結果，其純文字

檔存的引用格式即是一例。 

Am J Med Genet A. 2005 Mar 9; [Epub ahead of print] 

Reconstructing the behaviors of extinct species: An excursion into 

comparative Sampleneurology. 

Rogers SW.  

Salt Lake City VA-Geriatrics Research, 

Education and Clinical Center and Department of Neurobiology and 

Anatomy, University of Utah School of Medicine, Salt Lake City, Utah. 

How can the behavior of an extinct species be reconstructed-say a 

dinosaur such as Allosaurus? Despite the relatively abundant fossilized 

remains of this and other dinosaurs, the incompleteness of the fossil record 

has permitted room for considerable 
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speculation, mythology, and perhaps a bit of unsettling reflection on what 

factors contributed to the eventual fate of these remarkably successful 

animals. (continued) 

(c) 2005 Wiley-Liss, Inc. 

PMID: 15759265 [PubMed - as supplied by publisher] 

類似這種狀況，EndNote並無法明確辨識每筆書目之Title、Address、Abstract

等欄位是哪些書目資訊。 

為了要能夠對應此筆純文字檔上的書目資訊，每筆書目內容都須使用一致的tag

格式來對應到EndNote欄位。通常資料庫廠商會提供數種對應格式，請將參考文

獻存成Tag格式之純文字檔，以利EndNote匯入。本手冊從PubMed資料庫下載

為MEDLINE格式之參考文獻為例。 

PMID- 15759265 

OWN - NLM 

STAT- Publisher 

DA  - 20050310 

PUBM- Print-Electronic 

IS  - 1552-4825 

DP  - 2005 Mar 9 

TI  - Reconstructing the behaviors of extinct species: An excursion into 

comparative Sampleneurology. 

AB  - How can the behavior of an extinct species be reconstructed-say a 

dinosaur such as Allosaurus? Despite the relatively abundant fossilized 

remains of this and other dinosaurs, the incompleteness of the fossil 

record has permitted room for considerable speculation, mythology, and 

perhaps a bit of unsettling reflection on what factors contributed to the 

eventual fate of these remarkably successful animals. Among the 

speculations is how these 'bigger-than-life' creatures behaved, a topic 

that itself can attain equal diversity and grandeur. With recent 

advancements in measuring the relatedness of living organisms, how 

genetics contribute to brain development and how this relates to 

behavior, combined with the availability of newly discovered high quality 

fossils and imaging methods to exploit their secrets, novel insights into 

how extinct creatures such as Allosaurus intermingled with its many 

relatives over 100 million years ago are beginning to emerge. (c) 2005 

Wiley-Liss, Inc. 
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AD  - Salt Lake City VA-Geriatrics Research, Education and Clinical Center 

and Department of Neurobiology and Anatomy, University of Utah 

School of Medicine, Salt Lake City, Utah. 

AU  - Rogers SW 

LA  - ENG 

PT  - JOURNAL ARTICLE 

DEP - 20050309 

TA  - Am J Med Genet A 

JID - 101235741 

EDAT- 2005/03/11 09:00 

MHDA- 2005/03/11 09:00 

AID - 10.1002/ajmg.a.30538 [doi] 

PST - aheadofprint 

SO  - Am J Med Genet A 2005 Mar 9;. 

 

若未像以上每個欄位Tag皆對應到EndNote欄位，即可能無法正確將完整的書目

匯入到EndNote。 

 

一旦您以Tag格式儲存了書目資料，您還需要選擇適當的EndNote Filter來把資料

匯入。EndNote中已內建了針對不同資訊提供者所設計的Tag，共有數百個Filters

格式可供選擇。 

匯入匯入匯入匯入中國期刊全文數據中國期刊全文數據中國期刊全文數據中國期刊全文數據庫庫庫庫(CJFD)純文字檔至純文字檔至純文字檔至純文字檔至EndNote 

※ 使用IE 8瀏覽器 

1. 進入中國期刊全文數據庫查詢資料後，勾選所需資料並按“儲存”。 
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2. 點選“EndNote”後，點選“輸出到本地檔” 

 

3. 跳出檔案下載視窗，請記住檔名，並點選“儲存”將檔案暫存至桌面 
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4. 開啟EndNote，點選File→Import→File…。(或是點選 ) 

 

 

5. 點選Choose...，出現瀏覽檔案視窗，選擇剛剛暫存於桌面之檔案後，按“開

啟”。 
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6. 再從Import Option清單中選擇“EndNote Import”。 
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7. 之後再點選“Import”。 

 

8. 書目資料即會自動匯入至EndNote中。在Imported References群組中，即

可看到當次所匯入之書目資料(僅暫存於此)。 
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9. 要重新呈現所有在Library中的參考文獻，點選左方的All Reference群組，即

可查閱所有參考文獻。 

輸出格式全覽和匯入的輸出格式全覽和匯入的輸出格式全覽和匯入的輸出格式全覽和匯入的 Filter 選項選項選項選項 

如何選擇其他如何選擇其他如何選擇其他如何選擇其他 Filter 

1. 點選 File→Import→File…。(或是點選 ) 
2. Import Option 的下拉選單選擇“Other Filter” 
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3. 會出現一視窗呈現在EndNote Filters資料夾中內建的Filters。可在“Quick 

Search”直接輸入Filter名稱來查找。 

 

注意：目前，EndNote在視窗預列了100個最常被使用的filters，但EndNote本身

可在此輸入 Filter

的名稱 
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共有數百個filters可供選擇。 

Filter 清單清單清單清單 

下表提供一些針對不同資訊提供者建議使用之輸出格式。請依此清單下載適合的

Tag格式、選擇適當的Import Filter。若未來以下資訊有所變更，請與資訊提供者

聯繫，或參照EndNote官方網站http://endnote.com所更新之資訊，或是參考

EndNote Help下之Search for Help on…資訊中的Direct Export Formats and 

Import Formats下的Output Formats with Corresponding Import Options。 

資訊提供者資訊提供者資訊提供者資訊提供者    建議下載格式建議下載格式建議下載格式建議下載格式    Import FilterImport FilterImport FilterImport Filter

AARP AgeLineAARP AgeLineAARP AgeLineAARP AgeLine        There is no method for downloading data from this database. 

Instead, save the results screen as a plain text file with your web 

browser’s Save command. The resulting text file contains tags 

which are preceded by 18 spaces. 

Ageline 

(AARP) 

filter 

ACM Digital LibraryACM Digital LibraryACM Digital LibraryACM Digital Library    

(Association for (Association for (Association for (Association for 

Computing Machinery)Computing Machinery)Computing Machinery)Computing Machinery)    

Users with subscription access to this web site can save multiple 

records to a BINDER. Once saved, you can export the records in 

an EndNote format. 

Non-subscribers can download one record at a time: 

1. Create a search. 

2. Click on an article. 

3. Scroll half-way down the page and select DISPLAY EndNote. 

Limitations: 

Since only plain text files can be imported into EndNote, you 

cannot import images and graphics. 

Before importing, you may need to edit the file to insert a 

comma after corporate author names. Otherwise, EndNote will 

not be able to distinguish corporate authors from personal 

authors. 

EndNote 

Import 

CAS SciFinderCAS SciFinderCAS SciFinderCAS SciFinder  Save references in the "Tagged Format" (*.txt). SciFinder 

( CAS) filter 

CSA (formerly CSA (formerly CSA (formerly CSA (formerly 

CambridgeScientific CambridgeScientific CambridgeScientific CambridgeScientific 

Abstracts)Abstracts)Abstracts)Abstracts)  

From the CSA search results screen, click Save/Print/Email. On 

the Save/ Print/Email screen, select: 

Record Format: Full Format 

Save File Format: PCMac 

Various 

filters for 

CSA 

databases 

are provided 



 

 

95 

Click Save. Your Web browser asks where to save the file. If 

your Web browser lets you save in different file formats, make 

sure you save as a "Text Only" (*.txt) file. 

in the 

EndNote 

Filters 

folder. 

DIMDIDIMDIDIMDIDIMDI  1. Choose All Fields. 

2. Choose For Saving. 

3. Click the Display button. 

4. Save the data as plain text using your browser's Save As 

command. 

One may need to edit the data to prepare it for importing, e.g. 

make sure all the tags are flush left and intact, &c. 

URLs may need to be mended manually after importing. 

Various 

filters 

available at 

our EndNote 

Web site. 

EBSCO  More than 100 filters available under the EBSCO name for 

various databases. 

1. When viewing the contents of your EBSCO folder, select 

the items you wish to e-mail, then click the 'Export' link. 

Do not choose the 'Save' option as this will result in data 

in a format that is not quite suitable for import. 

2. In the Export Manager, choose "Generic bibliographic 

management software" then click the Save button. 

3. The data will appear in a new window in a format 

consisting of two-letter tags. Either choose File > Save 

As, or copy and paste the data into a text editor and save 

it there--in either case, you must save the file as "plain 

text." Do not save as a web page or HTML. 

4. Import the file using the appropriate filter. 

Various 

filters 

available at 

our 

EndNote 

Web site. 

EmeraldEmeraldEmeraldEmerald    Display the marked list, click "display for download (ASCII)," 

and then save as a plain text file. 

Emerald 

filter 
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The filter provided works for these Emerald databases: 

• Emerald Management Reviews  

• Emerald Computer Abstracts  

• Emerald International Civil Engineering Abstracts  

• Emerald Computer & Communications Security 

Abstracts  

• Emerald Current Awareness Abstracts  

Limitations: 

Page numbers are separated by a hyphen with spaces on either 

side of it. EndNote cannot remove the spaces. You will need to 

manually remove the spaces after importing. 

InfoTrac (Gale)InfoTrac (Gale)InfoTrac (Gale)InfoTrac (Gale)    From the E-Mail Delivery panel at the bottom of the marked list 

window, restrict the contents to Citation. Do not select Full 

Article. 

Limitations: 

Records often have extraneous information in the title field, 

which must be removed manually after importing. 

InfoTrac 

(GALE) 

filter 

INNOPACINNOPACINNOPACINNOPAC    Save references in the EndNote format. EndNote 

Import 

Knowledge Finder Knowledge Finder Knowledge Finder Knowledge Finder     1. Select the documents to be saved, then click 

View-Export-Email Selected.  

2. Export selected references in PC EndNote format to 

initiate direct export. 

You may have to save the file to your desktop, then double-click 

it to initiate the direct export feature. You may also e-mail 

records in the MEDLARS or MEDLARS w/ABSTRACTS 

format using this filter to import the data.  

Various 

filters 

available at 

our EndNote 

Web site. 

NERACNERACNERACNERAC  Save your file as plain text (*.txt). NERAC 
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PsycINFO PsycINFO PsycINFO PsycINFO     After marking the records you wish to download, select Full 

PsycINFO Record, and then click the Display Marked Records 

button. Select the text, then copy and paste it into a text editor, 

saving the file it as plain text (*. 

Use the 

PsycINFO 

( APA) 

filter. 

UnCover (INGENTA)UnCover (INGENTA)UnCover (INGENTA)UnCover (INGENTA)  Using your email software, save references emailed to you as a 

Plain Text or Text Only file. 

Uncover 

(INGENTA) 

VHL (Virtual Health VHL (Virtual Health VHL (Virtual Health VHL (Virtual Health 

Library)Library)Library)Library)    

1. After selecting the desired references, scroll to the bottom 

of the page and click "Your collection" (or "Su 

selleccíon). 

2. Cancel the print dialog, and then save the screen as a 

plain text file. 

Various 

filters 

available at 

our EndNote 

Web site. 

相關章節相關章節相關章節相關章節 

有關本章之相關介紹，可瀏覽 EndNote Help 下之 Search for Help on…資訊中 

�  Importing Reference Data 

�  Filters 

�  Direct Export Formats and Import Formats 
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第七章第七章第七章第七章：：：：匯入匯入匯入匯入 PDF 檔產生參考文獻檔產生參考文獻檔產生參考文獻檔產生參考文獻 

在本章節將為您介紹： 

� 匯入單一 PDF 檔案 

� 匯入 PDF 資料夾(多篇 PDF) 

� 設定自動匯入 PDF 資料夾 

� 匯入之 PDF 檔名設定 

 

執行 EndNote 程式，開啟 C:\Program Files\EndNote X7\Sample_Library_X7

檔案。 

匯入單一匯入單一匯入單一匯入單一 PDF 檔檔檔檔 

1.  開啟欲編輯的 Library 後，點選File→Import→File…，或是點選快捷

鍵 。  

 

2. 點選Import File的 Choose…的按鈕，出現瀏覽檔案視窗。 
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3. 選取要匯入 PDF 檔後再點選開啟 。 

 
4. 在 Import Option 的欄位中選取PDF 後，再點選Import. 
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5. 即可成功匯入。 

 

6. 若PDF內有DOI碼，則EndNote會自動連上網路找尋該篇文章之書目資

料，並自動帶入欄位資料。 
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提醒：若匯入的PDF檔，在文件的前兩頁有兩個DOI碼，EndNote 會將兩個DOI

碼都放入到參考文獻中DOI的欄位內，同時Title的欄位會放入PDF檔的檔名。 

 

PDF 自動命名自動命名自動命名自動命名 

NEW!! PDF匯入之名稱預設為使用者當初儲存PDF之名稱，若您想更改

PDF檔之名稱，EndNote現在可設定自動帶入Author, Year或Tltle做為PDF

匯入後之名稱。 
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1. 點選Edit→Preference 

 

2. 點選PDF Handling，在PDF Auto Renaming Options可自行選擇要何種

命名方式；在此選擇“Author + Year”為範例，選擇完後按確定。 

 

3. 之後再依據PDF匯入步驟匯入一篇PDF，即可發現PDF名稱已依據PDF
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之Author與Year資料來重新命名。 

 

4. 命名規則亦可在“Custom”中自行設定。 
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5. 點選“Custom”後，會自動跳出Rename Options視窗，可自行選擇各

欄位來組合成命名規則。 
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匯入匯入匯入匯入 PDF 檔案夾檔案夾檔案夾檔案夾 

1. 開啟使用的 Library 後，點選 File→Import→Folder…。 
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2. 點選 Choose…的按鈕，選擇欲匯入的 PDF 檔的資料夾(最上層的資料

夾)。  

 
3. Import Folder 下有兩個選項 

� Include files in subfolders：若選取的資料夾內有再區分多個資料

夾時，可勾選 Include files in subfolders 以便一次匯入多個資料

夾中之 PDF 檔。  

� NEW!!  Create a Group Set for this import：如勾選此項目，

EndNote 會根據您的資料夾名稱自動創造一個 Group Set。 
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4. 在 Import Option 的欄位設定中選取 PDF 後，點選 Import 即可。 

 

5. 所有資料夾內之 PDF 即會匯入，並依據您的資料夾名稱及階層創造一

個 Group Set。 
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    提醒：自動建立之 Group Set 只能建立至資料夾的第二層。 

 

設定自動匯入資料夾設定自動匯入資料夾設定自動匯入資料夾設定自動匯入資料夾 

NEW!!EndNote 現可設定一資料夾做為 “自動匯入資料夾”，先在偏好設定

中設定完畢之後，以後只要該資料夾內有新的 PDF 檔案，在開啟 EndNote

時即會自動匯入新的 PDF 檔案。 

1. 點選 Edit→Preference… 

依據匯入之資料夾

名稱及階層自動建

立之 Group Set。 
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2. 點選 PDF Handling，在 PDF Auto Import Folder 中勾選 Enable 

automatic importing 選項，並利用 Select Folder 按鈕選擇資料夾路徑。 

 

3. 點選 PDF Auto Import Folder 中的“Select Folder”，並選擇一資料夾

後按“確定”。 
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4. 設定完畢，以後只要一開啟 EndNote，即會自動偵測該資料夾有無新

的 PDF 檔案，若有新的檔案，即會自動匯入 EndNote Library 中。 

 

若資料夾

中有新的

PDF檔案 
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5. 已自動匯入至 EndNote 中之 PDF 檔，會自動存放在名為“Imported”

之資料夾中(系統自行產生的)。請注意：EndNote 只能自動匯入存放在

偏好設定中所設定的資料夾中第一層之 PDF 檔案，若 PDF 檔案存放在

您另外建立之子資料夾下，則無法自動匯入。 

 

開啟

EndNote時

即會自動

匯入 

新的 PDF檔案：下次

開啟 EndNote時即會

自動匯入 

存放在此資料夾之

PDF無法自動匯入 

此資料夾存放已匯入

之 PDF 
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PDF Viewer 

提供快速瀏覽參考文獻所附加的 PDF檔案，並提供以下功能： 

 

1. PDF 全螢幕預覽：點選 ，即可全螢幕預覽 PDF。 
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2. 點選 即可在 PDF上劃重點。 
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3. 點選 即可加入註記。 

 

提醒：離開 PDF Viewer 前請記得點選  以儲存任何變更。 
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相關章節相關章節相關章節相關章節 

有關本章之相關章節，可瀏覽 EndNote Help 下之 Search for Help on…資訊中 

�  Importing Reference Data 

�  PDF Handling Preferences 
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第第第第八八八八章章章章：：：：查找參考文獻查找參考文獻查找參考文獻查找參考文獻和建立和建立和建立和建立群組群組群組群組(Group) 

這個章節將引導您學習： 

� 建立個人群組(Custom Group) 

� 儲存參考文獻至CustomGroups中 

� 自檢索策略建立智慧群組(Smart Group) 

� 建立複合群組（Combination Group） 

開啟開啟開啟開啟Sample Library 

若還未執行 EndNote，請開啟 EndNote Program，並打開 Sample Library 檔案。

（開啟路徑為：File→Open→Open Library→磁碟 C→Program Files→EndNote 

X7→Examples→Sample_Library_X7）。 

 

查找參考文獻查找參考文獻查找參考文獻查找參考文獻 

假設您想查詢Sample Library中有關cognition方面，年代為2005-2013年的參考

文獻。 

1. 請先點選All Reference群組，並確認所有參考文獻都已呈現在Library視窗中。 

2. 請點選畫面上方的”Show Search Panel”選項，開啟Search視窗(點”Hide 

Search Panel”可將Search視窗隱藏)。 
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3. 一般在Search標籤會記憶著您上次有輸入過的檢索策略，若要清除，可點選

Options按鈕，選擇Restore Default。 

 

4. 請在第一個下拉選單點選 “Title”，指定EndNote在Title欄位中查詢；在第二

個下拉選單點選 “Contains”（指定EndNote查找欄位中有包含該查詢詞彙）。 

5. 在後方第一行空白欄位輸入查詢詞彙 “cognition”。 

 

6. 請選擇查詢年份2005到2013年。 

從第一欄下拉選單選擇Year欄位，對照欄位選 “Is greater than or equal to”，

然後在空白欄位輸入2005。 

7. 若查詢頁面未看到第三列欄位，請點選 按鈕新增一行。 

8. 同第六點步驟，一樣限定選擇Year欄位，對照下拉選單選 “Is less than or 

equal to”，然後空白欄位輸入2013。 

請注意在每一個查詢欄位最前端都有And、Or、Not布林邏輯的選單功能。請

依需求選擇適合的布林邏輯。以本例子而言，請皆選擇And，查詢視窗會呈

現如下畫面圖示： 

 

 

此查詢將會找到所有參考文獻中2005年到2013年並包含 “cognition”的文獻。 

注意：以下兩個勾選框分別是指： 

《Match Case》：勾此選項將限制您檢索詞彙“cognition”皆為小寫字母，如果在

句子中找到首字母大寫“Cognition”或是所有字母都大寫的“COGNITION”，

檢索項目 
布林

邏輯 
欄位選單 對照選單 



 

 

118

EndNote將不會查找出來。 

《Match Words》：勾此選項將限制檢索出完全符合的詞彙，例如以本例子來說，

我們輸入 “cognition”，EndNote就僅查詢符合“cognition” 詞彙的文獻，不支援

切截功能。 

9. 點選Search按鈕開始查詢；呈現檢索結果會直接呈現於上方的參考文獻視

窗。 

注意：隨著查到檢索結束，左邊Group視窗會出現個”Search Results”的群

組，呈現了這次查到的4筆書目；此群組為暫存模式，伴隨每次檢索行為才出

現，並會主動替換掉您上次檢索的檢索結果；當您關掉Library，此群組即自

動消失。 

 

 

NEW!!：EndNote X7新功能，在Quick Search可搜尋PDF及PDF註記資料。 

群組群組群組群組(Group) 

在 EndNote Library 左方的視窗為群組區，呈現該群組下所儲存的參考文獻。在

一個新 EndNote Library 中，預設有「All References」（Library 內所有的文獻資

料）、「Unfield」（尚未歸類的書目資料）、「Trash」（暫存被刪除的資料，可選擇

永久刪除清空）三個群組，如下圖所示。 

 

在這三個預設的群組下方，可建立大群組(Group sets)項目以及大群組下的個人

化群組；最多可設 500 個個人群組(custom groups)與智慧群組(smart groups)。 

 
所謂 Custom Group，是指使用者所新設的群組分類；而 Smart group 指基於設
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定好的檢索策略，而自動整合、產生之群組。 

參考範例 Library（Sample Library），可看到呈現的數個個人群組項目；點「Bats」

大群組，即可看到其下分的小群組，點小群組名稱，可看到各包含的參考文獻。 

 

 

 

 

建立個人群組建立個人群組建立個人群組建立個人群組(Custom Group) 

1. 至 Groups 選單→Greate Group。在群組中新建的群組名稱會呈現 New 

Group 預設字樣並反白，可直接輸入要建立的群組名稱。或是在 Avian 

Intelligence 大群組的位置直接按滑鼠右鍵，在選單中點選“Create 

Group”。 

 
 

可依群組名稱前的

圖示識別 大群組名稱大群組名稱大群組名稱大群組名稱 

個人個人個人個人群組名稱群組名稱群組名稱群組名稱 

智慧智慧智慧智慧群組名稱群組名稱群組名稱群組名稱 

可直接

輸入群

組名稱 

複合複合複合複合群組名稱群組名稱群組名稱群組名稱 
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2. 輸入“Avian Influenza” 為群組名稱，然後按下 Enter，或點選介面參考書

目清單區域即儲存。新建之群組，因尚未儲存任何參考文獻，故對應的參考

文獻清單區域為空白。 
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加入參考文獻加入參考文獻加入參考文獻加入參考文獻至群組至群組至群組至群組(Group)中中中中 

1. 請點至“All References”，找 Author 為 Bird 的參考書目與作者為 DeLong

的另一筆參考書目。

 
2. 利用按住滑鼠左鍵，拖曳這兩篇文獻到 Avian Influenza 群組上（或從 Group

選單→Add References To→Avian Influenza 加入）。 

 

可按住鍵盤上的

Ctrl 鍵，再分別點

選。 

出現 表有拖

曳成功，直接

放掉滑鼠即增

加成功 
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3. 點 Avian Influenza 群組即可在右邊視窗看到加入到該群組下的這兩筆參考

文獻。 

 
 

使用檢索策略使用檢索策略使用檢索策略使用檢索策略並建立一個智慧群組並建立一個智慧群組並建立一個智慧群組並建立一個智慧群組 

1. 在查考參考書目範例中，Search畫面仍維持在剛剛所下的檢索條件，此時，

可點Options→Covert to Smart Group；隨後，您即會看到在Avian 

Intelligence大群組下，新增了一個Smart Group。 

2. 請就新增之Smart Group更名為 “cognition_2005-2013”，做為這個檢索策略

之識別標題，並按Enter。 

 
3. 若還未更新到Smart Group群組名稱，其Smart Group名稱會預設為

「Converted Search」，則請點選這個群組名稱，按滑鼠右鍵→點選Rename 

Group，重新命名即可。 
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移動群組位置移動群組位置移動群組位置移動群組位置 

1. 點 Avian Influenza 群組名稱，持續壓住滑鼠左鍵然後進行拖曳，移到要更改

群組分類的位置。 

2. 拖曳 Avian Influenza 群組到 Bats 這個大群組分類下，直接放開滑鼠左鍵即

可。 

 



 

 

124

刪除一個群組刪除一個群組刪除一個群組刪除一個群組 

1. 在 Avian Influenza 群組名稱上，點一下滑鼠右鍵，自展開的選單中選 Delete 

Group，即可刪除該群組。 

 

2. 或先點 Avian Influenza 群組名稱，再點選 Groups 選單下的“Delete Group”

選項，也可刪除該群組。 

 
提醒：此刪除功能只會刪除群組，不會刪除在該群組內的 EndNote Library 參考

文獻。 
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建立複合群組建立複合群組建立複合群組建立複合群組（（（（Combination Group）））） 

在 EndNote Library 複合群組功能可以透過布林邏輯 AND、OR、NOT 來合併智

慧群組或是一般群組，讓使用者可以更方便的組織管理自己的文獻。 

1. 從 Groups 選單中選取 Create from Groups 叫出複合群組設定視窗。 

 
2. 建立複合群組名稱，並選取想要合併的一般群組或是智慧群組。 

 
 

輸入群組名稱 

下拉選單選擇群組 

增加、減少欄位 
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3. 設定群組布林邏輯的關係 。 

 
4. 點選 Creat 即可建立。 

 

下拉選單設定布林邏輯 
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相關章節相關章節相關章節相關章節 

有關本章之相關介紹，可瀏覽 EndNote Help 下之 Search for Help on…資訊 

� “Searching and Sorting in EndNote” to learn more about searching the 

EndNote library and saving references in groups. 

� “Groups” to learn more about creating and managing groups. 
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第第第第九九九九章章章章：：：：在在在在 Microsoft Word 中中中中使用使用使用使用 EndNote 

EndNote 的 Cite While You Write 功能在您成功安裝 EndNote 之後，即會自動

出現在 Word 2007、Word 2010 或 Word 2013 上方的工具面板中（它是一組

EndNote 的群組標籤）。透過 Cite While You Write 的功能，可使 EndNote 於正

在使用的 Microsoft Word 中，建立參考文獻的書目與引用格式。本章節以

Microsoft Word 2007 為範例，若使用不同文書處理器或版本，請參考 EndNote 

Help 下之 Search for Help on…資訊中的 Microsoft Word/Cite While You Write。 

本章節您將學習到： 

� 如何為投稿文章所撰寫之文獻建立文稿架構。 

� 引用EndNote內的參考文獻，並建立參考書目。 

� 引用資料但隱藏作者名稱和加上引用頁數之編輯。 

在在在在 Manuscript Template 中建立新文件中建立新文件中建立新文件中建立新文件 

假如，您寫了一篇有關 Evolution 之論文，並欲投稿至 Nature 這本期刊，要撰

寫符合 Nature 該出版社發表文章之投稿格式；您可透過 EndNote 中提供的

Manuscript Template 功能，讓您更快速簡單地建立您發表論文之電子檔文稿

架構、和寫作格式給出版社。詳細介紹，請參考 EndNote Help 下之 Search for 

Help on…資訊中的 “Manuscript Templates”。 

1. 從 EndNote 工具列 Tools 中選擇 Manuscript Templates。 
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2. 出現 Manuscript Templates 視窗，選擇 Nature.dot 範本，點選開啟，來套

用 Nature 撰寫文獻之範例架構。 

 

注意： 

(1) 如果您是第一次使用 Manuscript Template Wizard，您會收到一個巨

集的安全性警告畫面。請選擇接受巨集，勾選 “總是信任這個來源的

巨集” → 開啟巨集。 
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(2) 如果您使用的是 Word 2007，您必須使用以下方式開啟巨集。 

點選”選項”。 

 

 

 
點選 “啟用這個內容”→ “確定”，即會出現 EndNote Manuscript template wizard

視窗。 
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3. 出現 EndNote Manuscript template wizard 視窗，點選下一步(Next)。 

 
4. 輸入撰寫文章的篇名：”Theories About Evolution”，點選下一步(Next) 

 

5. 輸入該篇文章的作者姓名，首先選擇 Add Author 進行發表論文者的「作者

資訊」。在出現的視窗中點選 New，依序輸入作者姓名及相關資料，輸入完

點“確定”(OK)，您所輸入的作者會建立在 Author List 中，以同樣方式可再

建立第二位作者等其他作者資料。 

建立好所有作者資料後，按“確定”，再至上一層畫面選取這次發表文章的作

者，然後按 “OK”，再點 “下一步(Next)”。 
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6. 勾選這篇文章中所要呈現的資料，如正文、摘要、參考文獻、圖表等，選

擇完畢後點選下一步(Next)，之後點“完成”(Finish)。 

 

7. 點選完成後，系統會開啟 Word 檔案，以及剛剛所輸入的資訊和欲呈現的
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資料(如下圖)，您即可開始編輯這篇文章。 

 

引用引用引用引用 EndNote 中的參考文獻至中的參考文獻至中的參考文獻至中的參考文獻至 Word 

開啟一個開啟一個開啟一個開啟一個 Microsoft Word 文件文件文件文件 

以下說明將以開啟一個 Microsoft Word 新的文件檔為例。 

開始撰寫您的論文和插入引文 

1. 先在 Word 文件中，輸入您欲撰寫的文章內容，例如： 

This paper addresses the question of how the brain of an animal achieves 

cognitive integration-that is to say how it manages to bring its fullest 

resources to bear on an ongoing situation. To fully exploit its cognitive 

resources, whether inherited or acquired through experience, it must be 

possible for unanticipated coalitions of brain processes to form. This 

facilitates the novel recombination of the elements of an existing 

behavioural repertoire, and thereby enables innovation. 

現在，開始準備插入參考書目（引用）。 

請注意，在插入參考書目前，請先放置好您的滑鼠游標位置。 

2. 接著請選擇 Word 2007 工具面板中 EndNote X7 標籤。  

論文標題、發表論文者的基本

資訊、摘要、論文內容、研究

方法等，依版面指引您依序撰

寫文章內容。 
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3. 請點選「Insert Citation」下的「Insert Citation…」，接著跳出 EndNote X7 Find 

& Insert My References 視窗。在上方的空格中可以輸入任何關鍵字(例如：

作者、年代、作者名等)，您可在此輸入作者名 “Emery”，點選 Find，EndNote

會自動在您的 Library 中找出符合該條件的所有參考文獻。利用視窗下方可確

認該筆參考書目是否為您所引用的資料。在本範例中找到多筆符合資料。 

 

4. 確認某一筆書目(或多筆)資料無誤後，點選該筆(或多筆)資料，再點選 Insert，

即可在文章內文中插入這筆書目： 

EndNote 不僅插入書目，文章的最末端也會自動顯示該筆(或多筆)參考書目。 
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5. 您可以修改成您所需要的書目格式，點選 Style 下拉選單中的 Select Another 

Style…。 

6. 從選單中挑選適合的書目格式，例如，挑選 Nature 的書目格式，點選 OK。 
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7. 在正文中欲加入另一筆參考書目，可重複上述步驟。或是利用下方的另一種

方式插入書目： 

（1） 在 Word 2007 中先放置好您的滑鼠游標位置。 

（2） 接著請點選 Go to EndNote 按鈕。回到 Sample_Library_X7。 
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（3） 挑選您欲插入到文章內的書目，單筆或多筆書目資料皆可，再點選

Insert Citation 快捷鍵，Word 2007 文章中即會出現該筆(或該些)參

考文獻。 

 
（4） 或是您也可以在 Sample_Library_X7 選擇欲插入到文章內的書目資

料後，回到 Word 2007 的 EndNote X7 選擇 Insert Citation 下拉選單

中的 Insert Selected Citation(s)即可。 

 
（5） EndNote 會自動插入引用文獻，透過其 Cite While You Write 技術，

將您插入的參考文獻格式化為您指定的書目格式(例如選擇 Nature 格

式)，並顯示參考文獻於文章末端，呈現結果如下圖所示： 
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2. 假設您已經完成在 Word 文章中插入引用文獻的步驟。請點選 “儲存檔案”，

將文件命名之後儲存。 

注意：您也可以在註腳插入引用文獻。首先，經使用正確的 Word 指令進行註

腳(點選參考資料→插入註腳)。  

 

Word 會控制與分配註腳之數字；再依照插入參考文獻的方式操作，EndNote

會依照現有選擇的 Style 進行格式化，是故，您採用的書目格式，要本身有包

含註腳的書目格式，例如：Chicago 16th Footnote 格式，如此註腳功能才能

作用。而其參考文獻也會產生於文章末端。 
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選擇書目格式 

凡有套用 EndNote 參數的文件，您可以多次出版您的引用文獻和書目，改變

不同的輸出格式，並在其他版面編排設計格式。 

選擇選擇選擇選擇出版的書目格式出版的書目格式出版的書目格式出版的書目格式 

1. 從 Word 2007 的 EndNote 標籤→Bibliography 群組→請點選 Bibliography

群組名稱旁的箭頭符號。 

 

2. 經點選後，會自動跳出一個 EndNote X7 Configure Bibliography 對話視窗(如

下圖)，您可在此選擇書目格式。本範例，欲修改的 Format document 是以

剛剛示範的這篇文章 Cognitive Integration 做說明。 
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3. 接著在 With output style 選項，利用 Browse 鍵選擇其他書目格式，例如選

擇 Cognitive Development 格式，如此於該篇文章的引文之處，即會出現對

應 Cognitive Development 格式的參考文獻格式和清單。 

 

同樣地，您也可以看到，在 Browse 清單中尚有許多其他出版格式選項，若您想

改變輸出格式，再一次選擇其他書目格式即可。EndNote 會重新依您指定的格

式，改變文中引用格式與新格式之參考文獻清單。 

注意：目前 EndNote 已有超過 5000 種以上之 Style 格式。請在 EndNote 程式

中從 Edit 選單→按鈕選擇 Output Styles →選 Open Style Manager，可看到所有

格式清單。您可自清單，點選 “Get More on the Web”鈕下載更多或更新的

Styles，或以 EndNote 安裝程式點選完整的 styles 目錄進行安裝。 

點選 Browse

選擇其他書

目格式 
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為引用文獻與參考書目建立快速連結為引用文獻與參考書目建立快速連結為引用文獻與參考書目建立快速連結為引用文獻與參考書目建立快速連結 

1. 請在 Word 2007 從 EndNote 標籤→Bibliography 群組→點選 Bibliography
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群組名稱旁的符號鈕經點選後，會主動跳出一個 EndNote X7 Configure 

Bibliography 對話視窗。 

 

 
2. 使用者勾選 Underline Linked in-text Citaitions 的選項 

3. 使用者在文章內，點選某一筆書目並按住 CTRL 鍵，會自動跳自後方的對

應參考文獻。 
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編輯引用文獻編輯引用文獻編輯引用文獻編輯引用文獻 

如果您想更換整份文章的書目格式，可以利用 Format Bibliography 去修改“所

有”引用或文獻書目的輸出格式，EndNote 即會依照選擇之輸出格式重新出版。

然而，對於“個別”引用之更改，則是使用 Edit & Manage Citation(s)指令。 

對於一些書目格式，多數在引用上是以 Author 對應 Date 之格式呈現，但是若作

者的名字已經在文章段落中出現，則引用格式有的會規定無需重複出現作者名

稱。例如我們在文章該段落內容提及了 Morehouse 這位作者，則在這段落的文

獻引用上，作者名稱即該移除。另外，像我們可能僅參考某一篇文獻的部分頁數，

則您進行引用時，可能會希望顯示指定之頁碼。類似這種引用狀況之修改，可善

用下列步驟進行個別引用文獻編輯。 

編輯個別引用文獻編輯個別引用文獻編輯個別引用文獻編輯個別引用文獻 

1. 將滑鼠點選在 Emery 引用文獻上 

2. 從 Word 2007 的 EndNote 標籤中，選擇 Edit & Manage Citation(s) 
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3. 會自動跳出一個 EndNote X7 Edit & Manage Citations 對話視窗，請在下方

的 Formatting 中選擇 Exclude Author。 

4. 並在 Pages 中輸入 25。(或是多頁的格式 25-26) 

注意：在 Pages 框中輸入引用數字，應選擇 Citation Template 中有對應 Cited 

Pages 的功能，該格式才具支援，並確保頁碼會出現在引用之文獻。 

 

 

5. 點選 OK 更新 Word 中的引用狀況。 
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插入引用圖表插入引用圖表插入引用圖表插入引用圖表 

若您要在 Word 文件插入兩張引用圖表，一是圖片、一是表格。所有圖表引用文

獻插入方式都相同，故首先須確定選擇的書目格式是否具有插入圖表功能。 

找到和插入圖片引用文獻找到和插入圖片引用文獻找到和插入圖片引用文獻找到和插入圖片引用文獻 

1. 首先在文章中加入下方這段文字，並把滑鼠游標放在這句話的句點後方，例

如： 

As researchers look at evidence, even the crest on the modern cockatiel 

provides insight into the evolution of feathers. 
現在您可以準備插入圖表引用文獻 

2. 於 Word 2007 中，點選 Insert Citation→點選 Insert Figure。 

 

 
3. 跳出 EndNote X7 Find Figure(S)的對話框；請在 Find 前方空白欄位中輸入

bird evolution，點選 Search。 
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4. 會自動列出符合的文獻並顯示圖片，請點選 Insert。 

5. EndNote 即會自動將該圖片插入到正在撰寫的 Word 檔案中，其顯示的方式

是依據您所挑選的書目格式呈現。 
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找到和插入表格引用文獻找到和插入表格引用文獻找到和插入表格引用文獻找到和插入表格引用文獻 

1. 首先在文章中加入下方這段文字，並把滑鼠游標放在這句話的句點後方，例

如： 

While exploring the evolution of dinosaurs and birds, it becomes clear that 

Homo sapiens have occupied earth for a relatively short period of time. 
2. 從 Word 2007 的 EndNote 標籤，點選 Insert Citation→點選 Insert Figure（同

插入圖片之步驟） 

3. 在 Find 前方空格中輸入 hominid，點選 Find。 

4. EndNote 會自動列出符合的文獻和圖表，在此找到的是 Excel 格式的圖表。 
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5. 確認要插入的參考文獻後，點選該筆參考文獻，再點選 Insert，即可在文章

中插入該圖表(如下圖)。此外，您可修改圖表大小。 

注意：本範例是使用 Cognitive Development 格式。 
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※圖表 2 旁邊所顯示的文字，是從 EndNote Library 的 Caption 欄位而來。 
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※撰寫完論文請記得 Save 儲存檔案。您可繼續在論文中增加正文、引用書目、

引用圖片，EndNote 皆會繼續增加參考文獻、圖表等。 

將參考文獻清單利用將參考文獻清單利用將參考文獻清單利用將參考文獻清單利用 Category Bibliography 進行分類進行分類進行分類進行分類 

NEW!! 當您完成所有文章內插入參考文獻的動作後，您可以利用 Categorize 

References的功能，在文章最後的參考文獻清單中，依據不同的資料類型作分類。

有關本章之相關說明，可瀏覽 EndNote Help 下之 Search for Help on…資訊

Configure Categories (Microsoft Word)之章節。 
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1. 文章完成後，點選 Categorize References → Configure Categories。 

 

2. 會自動跳出 EndNote X7 Configure Categories 對話框視窗，左半部是預設

的 References 和 Category Headings。右半部上方的視窗是目前文章內已

插入的文章書目資料，可以看到的欄位包括：Author, Year, Title, Reference 

Type 和 Category，右邊下方的視窗則會顯示對應的詳細欄位書目資料。以

本範例來說，在左邊的 All References in Bibliography 共有六筆資料，而該

六筆資料也都尚未分類，因此 Uncategorized References 也顯示六筆資料。

Category Headings 顯示的是預設的兩個分類標目：Primary Sources 和

Secondary Sources。 

 

3. 您可以利用上方的 另外新增您想要使用的分類標目名

稱，將預設的兩個分類標目：Primary Sources 和 Secondary Sources 改掉。

以本範例來說，請先點選 Primary Sources 前方的減號 和

Secondary Sources 前方的減號 ，刪除預設的分類標目。再

點選 新增三個標目名稱：Books, Journals,Conference 

Proceedings。(可以自行命名) 
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4. 完成分類標目的新增之後，依據各筆書目資料的資料類型(Reference Type)

來作歸類。歸類的方式請先反白欲歸類之書目資料後，再將它們拖曳至對應

的分類標目中放置。以本範例來說，請先選擇 Journal Article 的兩筆書目，

再將它們拖曳至 Journals 的分類標目中放置。因此您可以看到 Journals 中

有兩筆書目資料。 

 

5. 當六筆資料都歸類完成後，Uncategorized References 中就無資料了。此

時，您在 Category 的欄位中也可清楚辨識出每筆書目資料所歸類的分類標

目。完成後分類清單後，點選 OK。 

6. 在文章最後的參考書目清單中(Reference Lists)即可看到每筆書目資料皆清

楚的呈現於所屬的分類標目下。 
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7. 此時您會發現 Categorize References 下的 Group References by Custom 

Categories 選項會自動打勾，這表示您已啟用分類標目的功能。若您暫時不

想啟用此功能，您可以再點選一次該選項，暫時取消此功能，則後方的參考

書目清單中(Reference Lists)就會恢復成沒有歸類的狀態。 
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8. 若您之後又再新插入書目至文章中，且保持啟用分類標目的功能，卻沒有將

該筆書目作歸類的動作，則該筆書目會自動被歸類在 Uncategorized 

References 中。反之，您若移除某個分類標目下的書目資料，該筆書目資

料也會因此被放進 Uncategorized References 中。因此請務必記得再次進

入 Categorize References → Configure Categories 項目中進行書目資料的

分類。 
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移除參數移除參數移除參數移除參數 

9. 文章完成後，從 Word 檔案 → 儲存檔案，即可儲存該篇具有 EndNote 參

數文章。 

10. 如要移除參數，從 Word 2007 的 EndNote X7 標籤，點選 Convert Citations 

and Bibliography→Convert to Plain Text 

 

11. 若您之前的文件有先儲存，則會跳出下方視窗，提醒您她會另外開啟一份沒

有 EndNote 參數的 Word 檔，點選確定即可。 
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12. 請將新開啟沒有 EndNote 參數的 Word 檔另存新檔名。如此您就同時擁有

一份有 EndNote 參數的 Word 檔，和一份沒有 EndNote 參數的 Word 檔。 

 

相關章節相關章節相關章節相關章節 

有關本章之相關介紹，可瀏覽 EndNote Help 下之 Search for Help on…資訊 

 

� “Microsoft Word/Cite While You Write” to learn about the process of 

citing references and creating bibliographies. 

� “Generating Bibliographies” to learn about generating and creating 

output styles. 
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第第第第十十十十章章章章：：：：在在在在 Microsoft PowerPoint 中中中中使用使用使用使用 EndNote 

NEW!!!EndNote 的 Cite While You Write 功能在 EndNote X7 版現在也會出現在

Microsoft PowerPoint 中了！在您成功安裝 EndNote 之後，即會自動出現在

Microsoft PowerPoint 2007， 2010 或 Word 2013 上方的工具面板中（它是一

組 EndNote 的群組標籤）。透過 Cite While You Write 的功能，可使 EndNote 於

正在使用的 Microsoft PowerPoint 中，建立參考文獻的書目與引用格式。本章節

以 Microsoft PowerPoint 2007 為範例，若使用不同文書處理器或版本，請參考

EndNote Help 下之 Search for Help on…資訊中的 PowerPoint 單元。 

本章節您將學習到： 

� 如何在PowerPiont的Slides中插入引用書目和參考文獻。 

� 如何套用EndNote X7內建的書目格式。 

在在在在 PowerPoint 的的的的 Slides 中中中中插入引用插入引用插入引用插入引用(Insert Citations) 

請先開啟 EndNote 程式，以下將以 Sample_Library_X7 為範例作說明。 

1. 開啟一個新的 PowerPoint 檔案，將下列文字貼入 PowerPoint 的 Slides 中： 

Pioneers in avian intelligence have found that although birds’ brains are 

very small, they are incredibly intelligent, and sometimes have surprising 

similarities to the behavior or brain functions of humans. 

 
2. 請先在 Style 中先挑選要套用的書目格式，本例選擇用 APA 6th。(注意：若

您沒有先選擇書目格式，就插入引用書目，這樣之後就無法作書目格式的

修改。)若下拉選單中沒有您需要的書目格式，請選擇 Select Another Style

作挑選。 
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3. 在 PowerPoint 的 Slides 中，將滑鼠游標放置於您欲插入引用書目的位置。 

4. 點選 Insert Citation，會跳出一個 EndNote Find & Insert My Citations 視

窗，在 Find 左方的空格中輸入查詢詞彙，可以是關鍵字、作者名稱、年代

等詞彙，本範例，請輸入 Laudato，點選 Find，即會查詢出

Sample_Library_X7 中符合此關鍵字的書目資料，確認後，點選 Insert。 

 
或是可以透過 Insert 旁的黑色倒三角形來挑選您需求的引用樣式： 

(1) Insert Button：直接套用您已經選擇的書目格式其預設的樣式。 

(2) Insert & Display as: Author (Year) ：呈現的樣式為作者(年代)。 

(3) Insert & Exclude Author：呈現的樣式僅會出現年代。 

(4) Insert & Exclude Year：呈現的樣式僅會出現作者。 
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另一種引用的方式介紹如下： 

 
1. 在 Sample_Library_X7 中點選一筆或多筆書目資料。 

點選 Insert套用 APA 

6th 預設的引用格式 
點選 Insert & Display as: 

Author (Year)所呈現的式樣 
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2. 回到 PowerPoint 的 Slides 中，將滑鼠游標先放置於您欲插入引用書目的位

置。接著，點選 Insert Selected Citation(s)。(注意：須先在 Style 中先挑選

要套用的書目格式，本例選擇用 APA 6th。) 

 

3. 其引用書目格式呈現如下圖： 

 

在在在在 PowerPoint 的的的的 Slides 中中中中插入參考書目插入參考書目插入參考書目插入參考書目(Insert References) 

請先開啟 EndNote 程式，以下將以 Sample_Library_X7 為範例作說明。 

1. 開啟一個新的 PowerPoint 檔案，將下列文字貼入 PowerPoint 的 Slides 中： 

Pioneers in avian intelligence have found that although birds’ brains are 
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very small, they are incredibly intelligent, and sometimes have surprising 

similarities to the behavior or brain functions of humans. 

 
2. 請先在 Style 中先挑選要套用的書目格式，本例選擇用 Numbered。(注意：

若您沒有先選擇書目格式，就插入參考書目，這樣之後就無法作書目格式

的修改。)若下拉選單中沒有您需要的書目格式，請選擇 Select Another 

Style 作挑選。 

3. 在 PowerPoint 的 Slides 中，將滑鼠游標放置於您欲插入引用書目的位置。 

 
4. 點選 Insert Reference，會跳出一個 EndNote Find & Insert My References

視窗，在 Find 左方的空格中輸入查詢詞彙，可以是關鍵字、作者名稱、年

代等詞彙，本範例，請輸入 Taylor，點選 Find，即會查詢出

Sample_Library_X7 中符合此關鍵字的書目資料，點選作者為 Taylor，年

代為 2012 的該筆資料後，點選 Insert。 

滑鼠游標放置位置 
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5. 其參考書目格式呈現如下圖： 

 

另一種插入參考書目的方式介紹如下： 

 
1. 在 Sample_Library_X7 中點選一筆或多筆書目資料。 
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4. 回到 PowerPoint 的 Slides 中，將滑鼠游標先放置於您欲插入引用書目的位

置。接著，點選 Insert Selected Reference(s)。(注意：須先在 Style 中先

挑選要套用的書目格式，本例選擇用 Chicago 16th Footnote。) 

 

2. 其引用書目格式呈現如下圖： 

 

注意：不管您在 PowerPoint 插入 Citations 或是 References，插入之後都沒有

參數存在，因此您皆可以利用原本 PowerPoint 所擁有的功能作編修的動作。 

參考書目前方的數字是利用 PowerPoint 原有的項目編號功能所加入的 
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相關章節相關章節相關章節相關章節 

有關本章之相關介紹，可瀏覽 EndNote Help 下之 Search for Help on…資訊中

PowerPoint 單元。 
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第第第第十十十十一一一一章章章章：：：：在在在在 OpenOffice.org Writer 使用使用使用使用 EndNote 

本章將引導您如何在 OpenOffice.org 的文書處理軟體(version3)利用 Cite While 

You Write 功能進行文章撰寫、建立引用與書目格式。 

本章節您將學習到： 

� 如何在文章中引用書目並建立參考書目。 

� 如何管理和編輯參考書目。 

� 如何修改書目格式(style)。 

文書處理軟體的相容性文書處理軟體的相容性文書處理軟體的相容性文書處理軟體的相容性 

請注意欲運用 EndNote 進行文章的引用時，只支援第 3 版以上的 OpenOffice.org 

Writer。若您使用的是比較早期的 OpenOffice.org 版本，請先將您的文件儲存成

RTF 檔（詳細可參見 EndNote Help 英文手冊 OpenOffice.org Writer/Word 

Processor Compatibility (OpenOffice.org Writer)→Basic Instructions (Format 

Paper)）。而當插入引用文獻與建立文件格式時，一次只能開啟(用在)一個檔。

經安裝完 EndNote X7 版本，理應在 OpenOffice.org Writer 會主動出現一個

EndNote X7 選單。若您是先安裝了 EndNote X7 後才安裝 OpenOffice.org 

Writer，會無法直接呈現 EndNote X7 功能選單，因此請您先安裝 OpenOffice.org 

Writer，再安裝 EndNote X7。 

OpenOffice.org Writer 的的的的 CWYW 指令列指令列指令列指令列 

經在 OpenOffice.org Writer 成功安裝 EndNote X7 後，會在 OpenOffice.org 

Writer 介面直接看到 EndNote X7 的 Cite While You Write 工具指令列。如下圖

所示。當您點選 EndNote X7 選單下的這 CWYW 任一功能，即會呼叫開啟

EndNote X7 管理軟體。 
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邊撰寫文章邊撰寫文章邊撰寫文章邊撰寫文章邊引用邊引用邊引用邊引用EndNote參考文獻至參考文獻至參考文獻至參考文獻至OpenOffice.org Writer 

引用形式介紹引用形式介紹引用形式介紹引用形式介紹 

這邊所指的引用(Citation)是指以圓括弧方式，就書目作者、年代資訊安插於您所

引用的文章段落。如下所示： 

 

……..of the species at hand1. 

 

……..of the species at hand (Argus, 1991). 

 
於您 OpenOffice.org Writer 文件中，可採用經套用格式化，或還未套用格式化

的 EndNote 書目文獻。 

 
未格式化的引用文獻未格式化的引用文獻未格式化的引用文獻未格式化的引用文獻 

 
對引用文獻資料，當你點選”Unformat Citation(s)”或手動對資料設成 unformatted 

citations，會顯現文獻未經套用書目格式的未格式化狀態。 

未經套用引用格式的文獻，會暫時地指出引用文獻所在位置，包含這筆文獻在目

前您 EndNote Library 所對應的文獻是哪一筆，亦即第一位作者名稱的姓、文章

出版年代，以及 EndNote 系統對該筆文獻的紀錄號碼(識別碼)（其格式如下所

示）；EndNote 本身是靠這些未格式化的資訊來判別它是哪筆書目。這些資料在
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您文章最後撰寫完畢輸出時，不會顯示出來。 

｛Author, Year #Record Number｝. 

例如： 

 {Alvarez, 1994 #8}  
對於這種未格式化的引用文獻，其實可做為一種引用文獻的簡單識別，特別是假

設您最後使用數字型的引用格式，此時您即可將所有引用資料改成未格式化狀

態，這樣在撰寫文章時，反而有助您辨識所引用的文獻資料。 

 
練習開啟 C:\Program Files\EndNote X7\ Samples\Sample_OpenDocType 範

例，如下圖所示，文章中的引用文獻即是未格式化的引用文獻。 

 

 
格式化的引用文獻格式化的引用文獻格式化的引用文獻格式化的引用文獻 

所謂的格式化，可指經指定套用在某一書目格式形式所輸出、呈現之格式狀態。

亦即，藉 “Format Bibliography”指令來轉換所有未格式化的書目成一指定的格

式，並反應在最後輸出文章的呈現上。舉如採用 Author-Date 的書目格式，其引

用格式會是： 

(Alvarez 1994；Turnhouse 1987) 

同樣的這筆書目資料，若改成 Numbered 格式，則會變成： 

[1, 2] 

 
您可很簡單地對格式化的引用文獻與未格式化的引用文獻直接互相轉換。 

 
練習開啟 C:\Program Files\EndNote X7\ Samples\Sample_OpenDocType 範

例，點選 EndNote X7→Format Bibliography，在 With output style 中利用下拉

選單，選擇 Numbered 格式，點選確定。 
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如下圖所示，文章中的引用文獻即是格式化的引用文獻。 
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 尋找與插入引用文獻尋找與插入引用文獻尋找與插入引用文獻尋找與插入引用文獻 

在 OpenOffice.org Writer 可以直接尋找 EndNote 的參考書目，並直接引用在文

章中，分別介紹如下： 

1. 開啟 C:\Program Files\EndNote X7\ Samples\ Sample_Library_X7。 

2. 開啟 OpenOffice.org Writer，新增一份文字文件，命名為「範例」，暫存於電

腦的桌面上，並貼上下列文字： 

“Birdbrain” should be a compliment. 

Pioneers in avian intelligence have found that although birds’ brains are very 

small, they are incredibly intelligent, and sometimes have surprising similarities to 

the behavior or brain functions of humans. Examples range from the cockatoo 

who was the first animal documented to dance to a beat to Irene Pepperberg’s 

in-depth studies done with the African grey parrot Alex (named for Avian 

Learning EXperiment).There have even been studies documenting that some birds 

successfully use, and even modify or build, tools. 

 
3. 請將游標點在第一個句點之後(您欲插入引用文獻的位置)。 
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4. 在 EndNote X7 選單中，點選 “Find Citation(s)”，讓畫面跳出一個 EndNote X7 

Find Citations 的對話框視窗。 

 

5. 請在 Find 的空白欄位中輸入欲查找的詞彙，EndNote 會就您所輸入的詞彙查

找、比對全部文獻（任一欄位）。本範例，請輸入 Holzhaider，點選 Search，

下方會出現對應的文獻，確認後，請點選 Insert。 

 

 
6. 點選“Insert”之後，即引用在您文章指定之處。若要更改書目格式，請選擇

EndNote X7→Format Bibliography，在 With output style 中利用下拉選單，

選擇 APA 6th，點選確定。如下圖： 
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在在在在 OpenOffice.org Writer 同時插入數筆參考書目同時插入數筆參考書目同時插入數筆參考書目同時插入數筆參考書目 

1. 自 EndNote 選單→Find Citation(s) 。 

2. 在查詢欄位輸入能讓您找到所要文獻的查詢詞彙→點 Search。 

3. 在查詢出來的參考文獻清單中，按住 Ctrl 鍵，點選您要一起引用的數筆文獻

書目。若按 Shift，則可連續反白、選取書目。 

4. 最後請點 Insert，即可插入引用文獻至游標放置處。 

 

插入您所插入您所插入您所插入您所已點選已點選已點選已點選的文獻的文獻的文獻的文獻 

1. 請開啟 OpenOffice.org Writer 文章，並將游標點在您要插入引用文獻的位

置。您可以利用剛剛的那份文件繼續練習，請將滑鼠游標放在第二個句點後

方。 

2. 請點 EndNote 選單，選 “Go to EndNote”選項。 

3. 在 Sample_Library_X7 點選您欲插入的引用文獻，可以單點一筆，或按住

Ctrl 鍵，點選數筆您要一起引用的文獻書目；或按 Shift 連續反白數筆選取書

目。以本範例，請點選兩筆書目。 
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4. 跳回畫面至 OpenOffice.org Writer 文章。點 EndNote X7 選單，並選 “Insert 

Selected Citation(s)”選項，即可插入引用文獻。 

 

 

 
透過 EndNote，可在文章任一段落同時引用數筆文獻，然而一次同時引用數筆

參考書目，有可能造成電腦突然變慢或甚至當掉，須注意一下大量引用之電腦反

應時間，建議執行動作後，請耐心等待電腦反應。 

 

同時在不同的同時在不同的同時在不同的同時在不同的 Libraries 插入您要引用的文獻插入您要引用的文獻插入您要引用的文獻插入您要引用的文獻 

我們可在數個不同的 EndNote Libraries 插入所要引用的文獻至 OpenOffice.org 

Writer。但我們仍建議一篇文章僅引用同一個 EndNote Library 的書目資料；如

此才能避免參考書目資料來源的混亂(尤其您是利用未格式化的方式來插入書目

時)，以確保您撰寫文章時，對您所引用的文獻有清楚的掌握，避免引用的重覆

和錯誤；因此您引用參考書目時，請開啟一個 Library 即可。 
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編輯參考書目編輯參考書目編輯參考書目編輯參考書目 

新增或移除書目新增或移除書目新增或移除書目新增或移除書目 

 
一旦您引用了文獻，並套用在某一書目格式後，請不要直接在文件中更改引用狀

況，因直接修改可能會造成該書目呈現之格式不正確。欲針對已經引用在文章中

的文獻進行新增或移除的動作，請參考下方正確的作法。 

1. 請在 OpenOffice.org Writer 文章中，點選 EndNote X7 選單→Edit Citation(s) 

 

2. 自動跳出 EndNote X7 Edit Citation 對話框。在文章中所有引用的書目資料，

會出現在對話框中的左邊欄位（區塊）。 
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3. 點選您欲刪除的書目（或欲再插入書目的位置處） 

� 點 Remove 移除該筆文獻 

� 點 Insert 然後選取您要新增加入的文獻。 

� 您可點選 Remove 右邊之兩個小的上下鍵 按鈕，改變一起引用

書目的排序位置。 

您可練習點選 Emery，再點選 Remove，最後點選 OK，即可從引用處將該筆書

目資料正確的移除。如下圖所示，該筆書目已移除引用文獻和後方的參考書目： 
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在已格式化的文章插入引用文獻在已格式化的文章插入引用文獻在已格式化的文章插入引用文獻在已格式化的文章插入引用文獻 

 
若您需新增一筆參考文獻在已引用某書目格式的文章中（如本章先前介紹），可

加入一筆新的參考文獻，並點 Format Bibliography 更新書目與引用狀況。 

若是新增一筆書目在已有引用文章的地方，可在該引用文獻之隔壁插入，例如：

(Hockney and Ellis, 1996){Argus, 1984 #1} 
相臨的第二篇文獻即會被 EndNote X7 依同樣書目格式合併，並排序在一起。例

如變成：(Argus, 1984; Hockney and Ellis, 1996) 

注意：不要點在引用文獻格式的中央進行插入文獻動作，請點在該引用文獻格式

之前或後，中間不要有任何空格。 

 
引用書目格式調整引用書目格式調整引用書目格式調整引用書目格式調整 

 
針對不同的書目格式規定，會有對引用格式做個別調整的需求，例如：在文章之

同一句或段落已有出現過作者名稱或年代，依照某些書目格式規定，這種引用文

獻的作者就不需再次出現作者名稱或年份。另外，您也可針對引用出處指定頁

碼，或在該引用文獻的前後加入註解。示範說明如下：  

1. 在 OpenOffice.org Writer 點選 EndNote X7 選單→Edit Citation(s)→跳出

EndNote X7 Edit Citation 對話框視窗。在文章中所有引用文章，會出現在對

話框中的左邊欄位（區塊）。 
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2. 在右邊的 Formatted Citation 可以選擇您要更改的選項，說明如下： 

 
� 原本引用格式： 

Hall’s discovery (Hall, 1988) 
� 不需出現作者名稱的狀況（Exclude author）： 

Hall said (1988) 
� 不需出現年份的狀況（Exclude year）： 

The report of 1988 (Hall) 
� 在引用格式之前加上註解字眼（Prefix）： 

The survey (see Hall, 1988) 
� 在引用格式之後加上註解字眼（Suffix）： 

The survey (Hall, 1988, table 2) 
� 在引用文獻的格式之後加上頁碼（Pages）： 

Hall’s report (Hall, 1988 p.4) 

 
個別設定修改引用格式個別設定修改引用格式個別設定修改引用格式個別設定修改引用格式 

 
以剛剛的範例來作練習，開啟 OpenOffice.org Writer 的文章，點選 EndNote X7

選單→Edit Citation(s)→跳出 EndNote X7 Edit Citation 對話框視窗。 

 
1. 在對話框右邊區塊，可看到能個別修改之客製化功能有： 

� 移除作者名稱：勾選 Exclude Author，剔除所點選文獻之作者名稱。 

� 移除年份：勾選 Exclude year，剔除所點選引用文獻的年份。 

� Prefix：在此空白欄位中，可在引用文獻的格式前加入您所要加註的詞

彙（並建議在詞彙後加入一個空格）。 

� Suffix：在此空白欄位中，可在引用文獻的格式後加入您所要加的詞彙

（例如”頁碼”，建議在詞彙前亦加一個空格）。 

� Pages：您可就指定的引用頁面，註明引用出處頁碼，並呈現之。但要

列印出來時，必須本身書目格式在引用樣式或註腳樣式有 Cited Pages

欄位；例如這種有頁碼的，一般只能套用在有支援這樣引用的幾個格式

上。 
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2. 點選 Holzhaider 這筆書目，勾選 Exclude year 選項。 

 
 

3. 點選 Smirnova 這筆書目，在 Prefix 輸入 see，在 suffix 輸入 ,table2 ，在

Pages 輸入，點選 OK。 
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4. 其調整結果如下圖所示： 

 

在註腳插入引用的參考書目在註腳插入引用的參考書目在註腳插入引用的參考書目在註腳插入引用的參考書目 

在 OpenOffice.org Writer 中的註腳/尾註(footnote)，插入引用的參考文獻，其做

法跟在文章內文中的插入參考文獻方式一樣： 

1. 開啟 OpenOffice.org Writer 的文章，將游標移至您要引用 EndNote 文獻的註

腳/尾註位置，點選工具列的插入→註腳/尾註。 

 
2. 將滑鼠游標放在頁尾下方，數字 1 的後方，點選 Find Citation，輸入查詢詞

彙作查詢，以本範例，輸入 vonk，點選 Search。 

3. 點選單筆或多筆書目後，點選 Insert 插入註腳/尾註。 
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4. 再點選 EndNote X7→Format Bibliography，在 With output style 中利用下拉

選單，選擇 Chicago 16th Footnote 格式，點選確定。其顯示結果如下圖： 

 

 
注意：使用 EndNote 註腳/尾註功能時，請選擇有支援註腳/尾註的書目格式，如

此才能正確套用指定之註腳/尾註格式。詳細請瀏覽 EndNote Help 下之 Search 

for Help on…資訊中 Citing sources as you write→Citing References in 

Footnotes and Endnotes (OpenOffice.org Writer)。 

 

轉成未格式化的引用格式轉成未格式化的引用格式轉成未格式化的引用格式轉成未格式化的引用格式 

透過 EndNote 可將已套用某一書目格式的引用書目轉回未格式化狀態，並移除

書目資料。特別是採用數字型的書目格式，可先設成未格式化的狀態，以便您在
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撰寫的文件中區辨，最後再整個轉成數字型書目格式(Numbered Style)。 

1. 先決定哪些引用書目您想要轉成未格式化： 

� 反白該筆引用書目。 

� 若是同時引用數筆書目的狀況，但只要轉其中一筆；也請選取該處多重

引用的所有書目為反白。 

� 若是要轉文件中的部份章節，只要選擇那個章節。 

� 若是要轉整份文件的所有引用書目，即無須做任何選取。 

 

2. 至 EndNote X7 選單→點選 Unformat Citation(s)，整份文件所有引用書目

去格式化後，那麼現有之書目也會一併移除。如下圖所示： 

 
注意：在文章中，若出現{Holzhaider, 2011 #2314}之引用格式，則表示

您文章的引用書目目前在“未格式化”的狀態。但未格式化的這些引用書

目最後並沒辦法呈現在輸出上，換句話說，也就是當您另存成新檔寄給別

人之後，打開也依舊呈現“未格式化”的狀態，所以您必須再選擇任一書

目格式，進行引用書目的格式化。 

3. 若欲格式化成某一書目格式，請點選 EndNote X7→Format 

Bibliography，在 With output style 中利用下拉選單，選擇 Numbered 格

式，點選確定即可。 
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注意：除非您的引用革是為數字格式，一般來說，還是建議您不要隨意點

選 EndNote X7 選單→Unformat Citation(s)，將書目格式變成 “未格式化

的狀態”，以免因不正確的調整或修改而造成錯誤的狀態。 

移動或複製引用文獻移動或複製引用文獻移動或複製引用文獻移動或複製引用文獻 

您可自文件中，任何複製含有引用書目的文句段落，並貼在文件中任何地方。請

在移動或要複製引用文獻時，確認您有完整選取了該篇引用文獻（含定義符號），

亦即包含該引用文獻前後的隱藏書籤(bookmark)；否則，您將只是複製表面文

字，而不是 EndNote 的引用文獻；接著，請就文件任一位置點選複製、貼上即

可。 

刪除引用文獻刪除引用文獻刪除引用文獻刪除引用文獻 

若您採用未格式化的引用文獻，可直接選取欲刪除的引用文獻（含定義符號），

並按 Delete 鍵或 Backspace 鍵刪除。 

但若您已經套用某一書目格式之引用狀態，像上述步驟直接選取、刪除（按 Delete

鍵等）會無法真正移除所引用文獻以及其隱藏的書籤，而致您文件引用文獻顯示

已刪除，可是對應它的參考書目還是在錯誤狀況。 

 
正確安全地刪除格式化的引用文獻正確安全地刪除格式化的引用文獻正確安全地刪除格式化的引用文獻正確安全地刪除格式化的引用文獻 

1. 在 OpenOffice.org Writer 文件中點選您欲刪除之引用文獻。 

2. 點 EndNote 選單→Edit Citation(s)→跳出呈現之 EndNote Edit Citation 對話

框視窗。 

3. 在對話框視窗左邊的區塊，點選您欲刪除的引用文獻。再點選 Remove→OK 
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產生書目清單產生書目清單產生書目清單產生書目清單 

格式化您的參考書目有兩種作用： 

� 藉格式化來統一文件的所有書目格式。 

� 對應文中所引用書目，產生一份書目清單（參考文獻）。 

格式化書目與改變書目格式格式化書目與改變書目格式格式化書目與改變書目格式格式化書目與改變書目格式 

不論您是否已經完成了文章撰寫與引用狀況，只要文章中有引用書目，即可進行

書目格式化作用。若再加入任何新的引用文獻，也能再格式化或改變書目格式、

設定輸出。 

1. 在 OpenOffice.org Writer 文件中，點 EndNote X7 選單→Format 

Bibliography→跳出 Format Bibliography 對話框。 

2. 在 Format Bibliography 頁面標籤下，選擇您欲輸出的書目格式或相關設定： 
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� With output style：選擇適當的輸出格式來格式化您的參考書目。可點選不

同書目格式，來展現不同格式之呈現結果。詳細說明可瀏覽 EndNote Help

下之 Search for Help on…資訊中 OpenOffice.org Writer \ Cite While You 

Write → Generating Bibliographies 單元。 

� Temporary citation delimiters：於未格式化的引用文獻有個起迄定義符號，

請注意它是一個定義符號（蜷曲的大括號），而不是只是文件中一個單純的

文元符號。 

3. 在 Layout 頁面標籤中，可以設定字型、字級大小、參考書目標提名稱等，相

關設定說明如下： 
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� Font and Size：後方參考書目的字型與大小設定。 

� Bibliography title：參考書目上面的標題名稱，可在此設定，例如輸入

“References”、”Reference List” 

� Text Format：將參考書目的標題反白→點選 Text Format 鈕→跳出對話框視

窗→更改您欲呈現之參考書目標題字型、大小和樣式(粗體、斜體、底線)。 

� Start with bibliography number：輸入您參考文獻的起始編號。 

4. 點選確定儲存變更，即可格式化您指定之書目格式與引用文獻。 

 

再再再再次次次次格式化您的文件格式化您的文件格式化您的文件格式化您的文件 

增加新的引用文獻至您已格式化過的文件增加新的引用文獻至您已格式化過的文件增加新的引用文獻至您已格式化過的文件增加新的引用文獻至您已格式化過的文件 

經格式化過您的文件後，又再新增引用文獻，可直接在 Format Bibliography

重複上述套用某一輸出格式方式：EndNote 選單→Fomrat Bibliography → 

OK，重新更新您的書目格式即可。 

進行進行進行進行 Cite While You Write 的喜好設定的喜好設定的喜好設定的喜好設定 

在 OpenOffice.org Writer 選 EndNote X7 選單→Cite While You Write 
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Preferences。 

 

� Open EndNote When Starting OpenOffice.org Writer 
勾選這個選項，當您打開 OpenOffice.org Writer 的文件時，則 EndNote 

Library 也會自動開啟。 

� Close EndNote When leaving OpenOffice.org Writer 
勾選這個選項，當您打開 OpenOffice.org Writer 的文件時，則 EndNote 

Library 不會自動開啟。除非您在 OpenOffice.org Writer 中啟動了一個 Cite 

While You Write 指令或重新勾選掉這個喜好設定，則 EndNote Library 才會

自動開啟。 

 

相關說明可參照瀏覽 EndNote Help 下之 Search for Help on…資訊中

OpenOffice.org Writer\Cite While You Write →General Preferences 

(OpenOffice.org Writer)單元。 

EndNote Library 與與與與 OpenOffice.org Writer 參考書目的參考書目的參考書目的參考書目的對應對應對應對應 

一旦您在 EndNote Library 中修改或刪除任何的書目資料，則 OpenOffice.org 

Writer 的文章，在經重新格式化書目後，能同時對應到 EndNote Library 更新過

的資料，將文章內所插入的引用文獻作更新。 

 

在在在在 EndNote Library 編輯一筆參考書目編輯一筆參考書目編輯一筆參考書目編輯一筆參考書目 

 
若您於 OpenOffice.org Writer 已先插入了某筆書目文獻，但之後卻在 EndNote 

Library 中對該筆參考書目重新作編輯(例如修改年代或是期刊名稱)，此時如果

您想更新您 OpenOffice.org Writer 文章內的參考書目，您需要在

OpenOffice.org Writer 文章中重新點選一次 EndNote X7 → Format 
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biobliography，再次格式化書目後（建議 EndNote Library 要同時開啟的狀態），

文章即可更新為修改過的內容到 OpenOffice.org Writer 文件中。 

1. 先在 OpenOffice.org Writer 文章內插入一筆參考書目。 

 

2. 到 EndNote Library 修改該筆書目之年代為 2012，點選 File→Save 儲存。 

 

3. 回到 OpenOffice.org Writer 文章，點選 EndNote X7 → Format 

biobliography，在 With output style 選擇 APA 6th 格式，點選確定。文章中

的書目資料即會自動修改年代為 2012，如下圖所示。 
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在在在在 EndNote Library 刪除一筆參考書目刪除一筆參考書目刪除一筆參考書目刪除一筆參考書目 

 
在您首次引用文獻時，EndNote 是透過每筆書目未格式化的訊息對應到打開的

EndNote Library；當您做了一次書目格式化的套用後，EndNote 會重新再讀一

次格式化後的資訊，並再對應一次到 Library 的書目。 

若您自 EndNote Library 刪掉了有引用的該筆參考書目，EndNote 則沒辦法循文

件引用的書目資訊到 Library 中找到對應的該筆書目資料。既使您再重新自

EndNote Library 建入那筆書目，這筆書目也會被給予另一個新的 EndNote 系統

紀錄碼；故對於您在 EndNote Library 刪除之參考書目，請您重新插入至

OpenOffice.org Writer 文件。 

 

EndNote 系統紀錄碼系統紀錄碼系統紀錄碼系統紀錄碼 

 
EndNote 對每筆書目會給予一個單一的識別碼，在未格式化的書目格式狀態即

會看到，其樣式如下： 

{Argus, 1991 #11} 
您也可以在 EndNote X7→Edit Citation(s)看到每筆書目之系統紀錄碼。 
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故請記得：當您新增一筆書目至 EndNote Library，EndNote 會給予其獨一以供

識別的系統紀錄碼；這些系統紀錄碼是系統自動提供的，所以使用者無法修改。 

若同樣的參考書目內容出現在不同的 Library，系統產生之記錄碼也幾乎不同 

(註：因前作者名稱與年份會一樣)。特別是，這些系統紀錄碼在同個 Library 底

下絕對不會重複，即使您刪掉了原本所匯入或新鍵入的那筆書目，也不會再重新

給予同樣的系統紀錄碼。是故，建議若您在 Library 刪掉了某筆書目，在文件上

請您再重新進行引用的動作，以確定套用在文件上的引用文獻能正確呈現。 

分享分享分享分享 OpenOffice.org Writer 文件文件文件文件 

當您想要自舊版的 OpenOffice.org Writer 或不同的文書處理軟體轉出您的文

件，在儲存不同檔案格式時，請先將引用的文獻轉成未格式化的格式，以利之後

能再進行書目格式化。 

在不同的電腦撰寫文章時在不同的電腦撰寫文章時在不同的電腦撰寫文章時在不同的電腦撰寫文章時 

若您是同一份文章，但在兩台電腦之間進行陸續撰寫，則請您需複製一份

EndNoteLibrary 的參考書目檔，以跟著您的文件在不同電腦中進行引用文獻套

用。也就是請您務必同時帶著您所撰寫的文件，以及對應的 EndNote Library。

若您今天在家的 EndNote Library 檔匯入了一筆新的參考書目，但公司在用的

EndNote Library_copy 版 卻沒有新增那筆參考書目，則即使文件中有新增該筆

新的參考文獻，但公司的 EndNote Library_copy 版沒辦法正確對應該筆新引用

書目。因此建議您同時將其儲存在同一個隨身碟中，以便於攜帶和在不同的電腦

中作編輯。 

 
當您原只是在一台電腦處理引用文獻，只要您是使用同一版本的 OpenOffice.org 



 

 

189

Writer，亦可移動文件到另外一台電腦去作編輯；只是當您使用的那台電腦沒有

灌 EndNote 或 EndNote Library 無法正常開啟時，在 OpenOffice.org Writer 則

無法進行書目格式化。  

儲存檔案至不同版本的儲存檔案至不同版本的儲存檔案至不同版本的儲存檔案至不同版本的 Writer 或文書處理軟體或文書處理軟體或文書處理軟體或文書處理軟體 

請注意的是，當您在不同版本的 OpenOffice.org Writer 打開您的文件，或使用

另存新檔(Save As)將您的文件儲存成另外的檔案格式，則原本套用在文件的

EndNote 格式會無法呈現。 

所以，若要以不同的文書處理軟體開啟您的文件、使用不同版本的

OpenOffice.org Writer、或在 Macintosh 系統處理，請您先將文件上引用的文獻

進行未格式化(Unformat Citations)，再存成不同的檔案格式。但請注意，未格式

化的書目格式，其實只是文件上的純文字記錄，並不會反應在最後的輸出上。其

他相關之未格式化的介紹，可參考 “Unformatting Citations (OpenOffice.org 

Writer)”單元。 

在在在在 Microsoft Word 與與與與 Writer 移動文件移動文件移動文件移動文件 

於您套用 EndNote 引用文獻的文件檔，可在 Microsoft Word 與 OpenOffice.org 

Writer 間互相使用。 

請記得在原本處理的文書軟體中，先將您的文件去格式化，並存檔；待至另一套

文書處理軟體打開此檔前，先確認該文書處理軟體已支援 EndNote 書目管理軟

體，即可打開後，再格式化您文件中的引用狀況和書目資料。 

下列幾項功能只有在 Microsoft Word 可以使用，目前尚未支援 OpenOffice.org 

Writer，分別是： 

� 使用手稿範本(Manuscript Templates)。 

� 插入註解(Insert Note)。 

� 插入圖表(Insert figure)。 

� 未支援立即更新格式化(Update Citations and Bibliography)。 

� 未能在同一份文件以章節的形式建立數份書目(Categorize References)。 

� 未支援從文件中建立參考書目至 Library 中(Traveling library) 

� 未能移除參數(Convert to Plain Text) 

相關章節相關章節相關章節相關章節 

有關本章之相關介紹，有關本章之相關章節，可瀏覽EndNote Help下之Search 

for Help on…資訊中Sharing Your Writer Documents (OpenOffice.org Writer)單

元。 
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第十第十第十第十二二二二章章章章：：：： 建立一個主題書目建立一個主題書目建立一個主題書目建立一個主題書目 

� 在這個單元，將教您如何利用各欄位建立和列印一個參考書目群組。 

開啟開啟開啟開啟 Sample Library 

請先執行 EndNote（開啟 EndNote 程式），並開啟 Sample_Library_X7 檔案。

(C:\Program Files\EndNote X7\Examples) 

選擇參考書目範圍選擇參考書目範圍選擇參考書目範圍選擇參考書目範圍 

1. 從您開啟的 EndNote Library 中，進行匯編參考文獻清單的動作 

2. 可限定查詢清單中的參考文獻，或只顯現選擇之參考文獻。本範例以選擇包

含所有在 Library 中的參考文獻進行說明。 

3. 確定所有的參考文獻都有顯現：從 EndNote → Reference → Show all 

Reference。如果 Show all Reference 呈現無法選取，則表示 EndNote Library

已經呈現所有參考文獻了 

選擇主題欄位和詞彙選擇主題欄位和詞彙選擇主題欄位和詞彙選擇主題欄位和詞彙 

1. 從 EndNote Library → Tools → Subject Bibliography → 呈現 EndNote 

Library 中的主題欄位。 

2. 將 Keyword 選取、反白。 

可依主題欄位進行單一欄位或數個欄位選取；通常會選擇 Keyword 欄位來進

行主題書目之建立。 
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3. 點選 OK，顯示利用 Keyword 欄位所找到的詞彙。 

4. 接下來會出現 Subject Terms 對話框。可選擇任何您想點選之詞彙；本例，

我們選擇所有關鍵字，以 Select all 為例。 
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5. 點選 OK，採用 Keyword 進行分析之主題書目即呈現在視窗上。 

 

改變書目輸出格式改變書目輸出格式改變書目輸出格式改變書目輸出格式 

1. 您可以在 EndNote Library 畫面上面的 Output Style 下拉選單，選擇不同書

目格式（本例正套用在 Numbered 格式上）。例如，選擇 Author-Date，參考

書目將會更新成 Author-Date 格式。您也可點 Select Another Style，選擇其

他 5000 多種之書目格式。 

關鍵字文獻數量 

關鍵字 
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2. 點 Output Style 旁的 “Layout”按鈕，可修改輸出格式與主題書目格式。 

3. 在 Layout 項目中，可改變 Reference List Title 為 Reference，或其他希望列

印時，出現之標題字詞；另外，也可改變每筆參考書目在呈現上的排序方式。 
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4. 在 Terms 項目中，可分別設定 

（1） Reference List 
您可選擇 Subject Terms Only，只呈現主題標題、不呈現參考文獻之格式。

選擇 Subject Terms and Reference List，一起呈現主題標題與參考文獻。

本範例，選擇 Subject Terms and Reference List 和 Recycle Numbering 為

例；經勾選 Recycle Numbering，當您採用數字型的書目格式時，即可看到

其上各關鍵詞彙下所列之參考書目編號，採用續號的方式呈現。 

可修改為 Reference 
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（2） Include 
在此項目中，您可勾選 Subject Term Counts 呈現主題詞彙的數量，或

勾選呈現每筆書目的系統紀錄碼。 

（3） Subject Term Layout：主題詞彙輸出排序樣式 

By Term – Alphabetical (按字母順序排列) 

By Term – Inverse Alphabetical (按反向字母順序排列) 

By Term Count– Ascending (按主題詞彙數量遞增排序) 

By Term Count– Desending(按主題詞彙數量遞減排序) 

（4） Styles：主題詞彙的字體樣式，例如：粗體、斜體、底線、大寫等式樣。 

5. 請注意的是，在 Bibliography Layout 項目中，若採用 Author-Date 輸出格式，

其選定的起迄欄位，在呈現參考文獻上會沒有嵌入空格，而接連著參考書目

內容。可於 Hanging Indent 選擇欲呈現的方式，是否要做每筆參考書目版面

縮排的呈現。 
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6. 點選確定，儲存改變設定。 

7. 在主題書目視窗中我們還可使用的功能如下： 

（1） Print Preview：您可以預覽主題書目列印的樣式。 

（2） Print：列印主題書目。 

（3） Save：儲存主題書目，並選擇您想要的儲存格式 text、rtf、html。 

縮排 
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8. 點選 Close 來關閉主題書目視窗，回到 EndNote Library 中。 

相關章節相關章節相關章節相關章節 

有關本章之相關介紹，可瀏覽EndNote Help下之Search for Help on…資訊中的

Subject Bibliographies and Subject Lists單元。 
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第十三第十三第十三第十三章章章章：：：：Library 備份與備份與備份與備份與分享分享分享分享 

將將將將 Library 壓縮並備份壓縮並備份壓縮並備份壓縮並備份(Compressed Library) 

使用者可利用EndNote的壓縮功能，將所有EndNote library的資源及夾帶的資

料，壓縮成另一個檔案，以便將個人的EndNote Library備份在其他裝置中或分

享給其他人。 

1. 請點選 File 工具選單中的 Compressed Library(.enlx)。 

 

2. 會自動跳出一個 Compressed Library 視窗，請選擇 Create 來建立一個壓縮

檔，右方可自行選擇是否連同夾帶的檔案一起做備份(With File Attachments / 

Without File Attachments)。下方區塊為選擇欲壓縮的參考資料範圍。 

(1) All References in library：Sample_Library _X7 中所有的參考書目皆作

備份或分享。 

(2) Selected Reference(s) ：可以單獨挑選某些參考書目作備份或分享。 

(3) All References in Group/Group Set：可以從下拉選單中挑選某一個

Group 中的參考書目作備份或分享。 
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3. 依使用者的需求選擇好後，請點選 Next。 

4. 接著請在 Save Compressed Library 視窗選擇存放的路徑並將其命名。 

注意：命名請儘量使用數字或英文來作為檔案的名稱。 
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5. 重新點選剛剛存放備份的路徑，即可看到副檔名為.enlx 的壓縮檔。 

 

6. 雙點擊此檔(上方圖示)，即會在您存放的路徑中自動產生兩個檔案，一個是

Sample_Library_X7_Back up.enl 和 Sample_Library_X7_Back up.Data。 

 

與與與與 EndNote Web 同步同步同步同步 (Sync with EndNote Web) 

自 EndNote X6 版本開始，新增了「Sync」功能之後，EndNote X7 依舊有提供

此功能讓使用者可以透過 Sync with EndNote Web，同步個人的 EndNote 

Library(單機版) 與 EndNote Web(線上版)的參考書目資料。請點選 EndNote 
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Library 上方的「Sync with EndNote Web」圖示。 

 

我尚無我尚無我尚無我尚無 EndNote Web 帳號帳號帳號帳號 

1. 請點選該畫面中的 Sign Up 來進行註冊。 

 
2. 請在下方畫面輸入兩次您的 E-mail 信箱。(gmail,yahoo,pchome 皆可) 

 
3. 請將下方畫面中有*號的欄位填寫完成，並於畫面最下方點選「I Agree」。 
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4. 完成後，即可點選「Sync」 按鈕進行同步。 
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我我我我已有已有已有已有 EndNote Web 帳號帳號帳號帳號 

1. 請於下方的畫面中輸入您的 E-mail 和密碼後，點選 OK。 

 

注意：不管您是新註冊或是已有 EndNote Web 帳號，在您填寫完畢之後，

Sync Preferences 的頁面即會自動帶入您的註冊信箱和密碼。 

 

XXX@xxx.c
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2. 第一次同步時，EndNote Library 會彈出一視窗詢問使用者是否需要將目前

的檔案進行壓縮備份。若需要備份，請點選「是」，若不需要備份，則點選

「否」。(建議是請作備份會比較安全) 

 

3. 備份完畢之後，EndNote 即會開始進行同步的動作。 

NEW!!! EndNote X7 新功能：同步正在進行時，會在右下方出現同步的處理訊

息，而且同步的功能會在背景中執行。 

 

4. 同步完成後，點選 Sample_Library_X7 的左方面板中會出現 Sync 

Satus…，點選後會出現本次同步的詳細資料。 
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首次進行同步時，兩邊的檔案會以聯集的方式進行整合，以本例來說，

EndNote Library 中原有 59 筆資料，EndNote Web Library 中有 33 筆資料，

兩邊資料均不重複的前題下！首次同步時，EndNote Library 會增加由

EndNote Web 同步來的資料 33 筆，EndNote Web 亦是增加從 EndNote 

Library 同步來的資料 59 筆。所以兩邊同步後的參考書目總數為 92 筆。 

EndNote Library 與與與與 EndNote Web 同步時的注意事項同步時的注意事項同步時的注意事項同步時的注意事項 

1. 當您透過 EndNote Library單機版註冊 EndNote Web帳號後，EndNote Web 

Library 中可儲存 5 萬筆參考書目以及擁有 5GB 的夾帶檔案空間。同步時，

會自動將附加檔案也同時同步，唯要注意單一附加檔案大小不可超過 1G。

您可以從 EndNote Web “選項”標籤下的 “帳戶資訊” 檢視您帳號的到期

日。 
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2. EndNote Library 中的 Group Set、Smart Group 與 From Groups 的群組資

料不在同步的範圍內，這些群組將不會被同步到 EndNote Web 中。 

3. 若從 EndNote Web Library 同步下來到 EndNote Library 的書目資料被歸類

在 Unfiled Groups 時，請自行手動作歸類。 

4. NEW!!!若您的 EndNote Web Library 中有 Shared Group，以本範例來說，

將 Linguistics 設定為共用的資料夾，因此它會被同步到單機版上的 Library

中，可以用圖示來作識別。 
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5. EndNote 八版或八版以上的 EndNote Library 才有跟 EndNote Web 同步的

功能。 

6. 若在某一個 EndNote Library(不管是單機版或是線上版)的 Trash group 中有

書目資料，則該些書目資料也將被同步到另一個 EndNote Library 中。 

 

 
7. 任何在 EndNote Library 或是 EndNote Web 上對書目資料和附加檔案的新

增、修改或是刪除的動作，同步時，無論是在 EndNote Library 或是 EndNote 

Web，也會同時的新增、修改或是刪除，這部分務必要小心注意。 

8. 可以透過 Edit 工具選單中的 Preferences→Sync 來進行同步頻率的修改，

若勾選自動同步 “Sync Automatically”， EndNote Library 每 15 分鐘會

自動與 EndNote Web 進行同步。 
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9. 同步功能適用於一個 EndNote Web 帳號與一個 EndNote Library，若使用

者想將多個 EndNote Library 與 EndNote Web 來進行同步，點選 Sync 同

步圖示時，EndNote 會彈出一警告視窗提醒使用者。

 

10. EndNote Web 的新增的群組，例如註冊 ResearcherID 時產生的 My 

Publications、Publication List 1 與 Publication List 2 等群組，同步時，在

EndNote Library 中會被歸類到 Unfield Groups 的類別下，使用者需要手動

進行該群組的分類。建議您自行在 EndNote Library 中新增一個

ResearcherID group set，再將該些書目資料進行歸類。
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11. 同步時，若 EndNote Library 或是 EndNote Web 上有重複資料，該重複資

料不會進行刪除的動作。在 EndNote Library 中，使用者需要透過 EndNote 

工具列中的 References 選單→Find Duplicates 的功能來進行重複資料的比

對。在 EndNote Web 中則是選擇 Organize(整理)功能下的 Duplicates(尋找

重複項目)功能來進行重複書目資料查找。 

 
12. 在 EndNote Library 的 Online Only mode 模式下，EndNote library 將無法

與 EndNote Web library 進行同步。 

 

相關章節相關章節相關章節相關章節 

有關本章之相關介紹，可瀏覽EndNote Help下之Search for Help on…資訊中的

EndNote Web單元。 

 

 


